## Contents

### Chapter 1 Introduction ......................................................... 1
- About this Document ......................................................... 2
- Conventions Used ............................................................. 2
- Where to Find Information about Your System .......................... 3
- Warranty Information ......................................................... 3
- Contacting Us ..................................................................... 5

### Chapter 2 Operation ............................................................... 7
- Operating Precautions ......................................................... 7
- Overview of the Nicolet iS50 Spectrometer ............................... 8
  - Sample Compartment Accessories ...................................... 8
  - Application Modules ......................................................... 8
- Spectrometer Components .................................................. 9
  - External Features ............................................................ 9
  - Internal Features ........................................................... 18
- The Back Panel ................................................................. 27
- Using Your Spectrometer ..................................................... 29
  - Turning the Spectrometer On and Off ................................. 29
  - Opening the Sample Compartment .................................... 30
  - Closing the Sample Compartment ..................................... 30
  - Removing the Sample Compartment Cover ......................... 31
  - Replacing the Sample Compartment Cover ........................ 31
  - Removing the Back Cover (Non-ABX) ................................. 32
  - Replacing the Back Cover (Non-ABX) ................................. 33
  - Opening the Beamsplitter Compartment Hatch .................... 33
  - Closing the Beamsplitter Compartment Hatch ..................... 35
  - Removing the ABX Cover .................................................. 35
  - Replacing the ABX Cover ................................................. 36
  - Installing the Standard Sample Holder ............................... 36
  - Removing a Standard Sample Holder ................................... 37
  - Inserting a Sample into a Sample Holder ............................. 37
  - Adjusting the Sample Height in a Sample Holder .................. 38
  - Installing a Sample Compartment Filter in a Sample Holder .... 38
  - Installing a Sidewall Adapter .............................................. 39
  - Using the Automated Purge Shutters (Optional) ..................... 39
  - Changing a Detector .......................................................... 39
When Do I Need to Open the Spectrometer Covers? ............... 102
When Should I Align the Spectrometer? ............................. 102
Does My Detector Need to Be Cooled With a Cryogen? .......... 102
When Should I Change the Desiccant? .............................. 103
Which Source Should I Use? ........................................ 103
Should I Turn off the Spectrometer When I’m Not Using It? .... 103
How Can I Diagnose Problems with the Spectrometer? ......... 104
How Do I Replace Parts in the Spectrometer? ...................... 104

Chapter 5  Maintenance .................................................. 107
Static Electricity Precautions ......................................... 107
Cleaning the Spectrometer ............................................. 107
Cleaning the ABX Cover ............................................... 108
Maintaining Detector Dewars ......................................... 108
Checking Internal Humidity ........................................... 109
Replacing the Desiccant ................................................. 109
Regenerating the Desiccant ............................................ 110
Checking and Changing the Purge Gas Filter ....................... 111
Aligning the Spectrometer ............................................. 112
Aligning an Accessory ................................................. 113

Chapter 6  Diagnostics .................................................... 115
Checking Spectrometer Components ............................... 115
Advanced Diagnostic Tests ........................................... 116
Dual-Channel Diagnostic Test ....................................... 117
Step-scan Diagnostic Test ........................................... 118

Chapter 7  Service ........................................................ 121
Installing or Removing Optional Hardware ....................... 121
Installing a Purge Kit .................................................. 121
Removing and Installing an External Beam Port Cover ......... 127
Installing and Removing an Optical Beam Port Window ....... 130
Installing an Optical Filter .......................................... 133
Replacing Components ............................................... 138
Replacing the Light Source ............................................ 138
Replacing the Laser .................................................... 140
Replacing the Power Supply ......................................... 140
Replacing the Sample Compartment Windows .................... 141

Chapter 8  Troubleshooting ............................................... 147
Software Problems ..................................................... 147
Hardware Problems .................................................... 149
Applications Problems ............................................... 157
Error Messages ........................................................ 160
Alignment Error ......................................................... 160
The Spectrometer is not Scanning .......................... 161
Humidity Level Inside Spectrometer is too High ................. 161
Computer Cannot Communicate with Spectrometer ............... 161
Spectrometer Cannot Communicate with the Detector ........... 162
Spectrometer Temperature is out of Specification ............... 162
Power Supply is out of Tolerance .......................... 162
Laser is out of Specification .............................. 162
Laser Temperature is out of Specification ...................... 163
Laser Frequency is out of Specification ....................... 163
Electronics Module is not Responding Properly ............... 163
Source Voltage is out of Specification ....................... 163
MCT Detector is Warm or Saturated ......................... 163
Communication Error .................................... 164
Motor Error ........................................... 164
Motor Timeout ....................................... 164
Motor Not Responding .................................. 164
ABX is Missing a Beamsplitter ................................ 164
Setting Smart Purge Controls ................................ 164

Chapter 9 Research Module .................................. 165
Dimensions ............................................. 165
Connecting an External Detector to the Spectrometer ........ 166
Pre-configured Advanced Experiment Kits ...................... 166
Introduction

The Thermo Scientific Nicolet™ iS™ 50 spectrometer is an FT-IR spectrometer with integrated features for performing a wide range of experiments and applications. The system includes performance verification features, a powerful software suite, and many other features that make it easy to collect data and get the answers you need.

Note  The optional ValPro Qualification is a comprehensive system qualification package that can be used instead of, or in addition to, performance verification. Refer to your ValPro documentation for more information.

The Nicolet iS50 spectrometer performs chemical analyses of sample materials by collecting data in the mid-IR, far-IR and near-IR spectral ranges using a variety of accessories. The system integrates advanced instrument features, such as step-scan and dual-channel data collection, with a powerful software suite and many other features that make data collection easy.

NOTICE  Be sure that all persons operating this system read the site and safety manual first.
The spectrometer site and safety guide that came with your system contains important safety information. Before you use the system, read the entire guide. To prevent personal injury and damage to equipment, follow the safety precautions contained in the guide whenever you use the system.

**About this Document**

To find information in this document:

- Click items on the Bookmarks panel or Contents page
- Click the Find box and enter a key word

To view the electronic Help version of this document, choose Spectrometer Help Topics from the Help menu in OMNIC software.

**Conventions Used**

Safety precautions and other important information use the following format:

- **WARNING** Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

- **CAUTION** Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

- **NOTICE** Follow instructions with this label to avoid damaging the system hardware or losing data.

- **Note** Contains helpful supplementary information.

- **Tip** Provides helpful information that can make a task easier.
Where to Find Information about Your System

We recommend first using the online documentation provided with OMNIC software when you have a question. The OMNIC software includes online tutorials and a complete Help system.

Tutorials

The following tutorials are available through the Help menu in OMNIC software.

Getting Started With OMNIC – This tutorial introduces you to OMNIC software. It includes information about the OMNIC window, using the toolbar and tool palette, creating and using spectral libraries, creating experiment files, and using online laboratory notebooks to create and save reports.

Beginner's Guide to FT-IR – Run this tutorial to learn how an FT-IR spectrometer works and the theory behind FT-IR spectroscopy.

Sampling Techniques – This item in the Help menu gives you access to the “Choosing a Sampling Technique” tutorial, which helps you choose the best technique for your analysis. Also available are tutorials describing how to install and use a number of sampling accessories, including Smart Accessories.

Learning OMNIC – This item in the Help menu gives you access to tutorials that explain how to use OMNIC software to collect spectra and perform a number of other software operations.

Spectrometer Documentation

Spectrometer documentation is available as .pdf and .wmv files, which is already installed on your system. Double-click the “Nicolet iS50 Documentation” icon on your computer desktop to launch and view the documentation.

Warranty Information

Thermo Fisher Scientific warrants that each product we sell is free from defects in labor and materials and shall conform to its product specifications as defined in the product user documentation. If the product does not function as warranted during the warranty period, we will repair or replace it without charge. If in our judgment we are unable to do so, you may return it to us and we will refund your money.

This warranty replaces all other warranties, expressed or implied, including the implied warranties of merchantability and fitness for a particular purpose and any other obligations or liabilities on the part of Thermo Fisher Scientific whether in contract, warranty, negligence or otherwise. Thermo Fisher Scientific shall not be liable for and disclaims all consequential, incidental and contingent damages.
Warranty Period

The system warranty period is 12 months in the U.S.A. and Canada. The warranty period begins on the date of installation or 30 days from the date of invoice, whichever is sooner.

The system warranty period for products sold outside the U.S.A. and Canada is 12 months from the date of installation or 14 months from the date of shipment, whichever is sooner.

Limit of Warranty

Misuse, accident, modification, unsuitable physical or operating environment, improper maintenance, or damage caused by a product for which we are not responsible will void the warranty.

Consumables are not covered under warranty.

Items Not Covered by Warranty

We do not warrant uninterrupted or error-free operation of a product. We provide certain non-Thermo Fisher Scientific products on an “as is” basis. Non-Thermo Fisher Scientific manufacturers or suppliers may provide their own warranties. A separate software warranty is provided with the software user documentation.

**NOTICE**

- Inside the shipping box, the instrument is sealed in a plastic bag to keep the optical components dry.

- You must allow 24 hours for the instrument to reach room temperature before opening the bag. If the bag is opened before the instrument reaches room temperature, moisture could condense on the optical components and cause permanent damage.

Your warranty will not cover:

- Damage due to improper moving techniques.

- Missing or damaged parts if the shipping boxes are unpacked before our service engineer installs the system.

- Damage due to removing the sealed plastic bag before the instrument has come to room temperature.
Contacting Us

For U.S. Technical Support, please contact:
Thermo Fisher Scientific
5225 Verona Road
Madison WI 53711-4495 U.S.A.
Telephone: 1 800 532 4752
E-mail: us.techsupport.analyze@thermofisher.com
World Wide Web: http://www.thermo.com/spectroscopy

For International Support, please contact:
Thermo Fisher Scientific
Telephone: +1 608 273 5017
E-mail: support.madison@thermofisher.com
World Wide Web: http://www.thermo.com/spectroscopy
**Operation**

The Nicolet iS50 spectrometer provides powerful tools with easy operation. This operations help guide will take you through the basic steps in designing experiments and working with the instrument. With this information, you can collect and analyze data using a variety of tools, like spectral math, identification and quantification.

**Operating Precautions**

**NOTICE**  Be sure that all persons operating this system read the site and safety manual first.

The spectrometer site and safety manual contains very important information and is available in several languages. Contact us for information about the languages that are available. Before you use the system, read the entire manual. To prevent personal injury and damage to equipment, follow the safety precautions contained in the manual whenever you use the system.
Overview of the Nicolet iS50 Spectrometer

The Nicolet iS50 spectrometer is a multirange applied-research FT-IR spectrometer that automatically configures its optics and changes instrument components based on the requirements of the experiment.

The main spectrometer is offered in two configurations: single range/manual multirange and advanced automated multi-range. The spectrometer hosts the sample compartment, up to two sources, up to three detectors and various input and output beams, purge shutters, filters and an IR polarizer. These configurations can be upgraded in a number of ways.

Sample Compartment Accessories

Many different accessories can be installed and used in the spectrometer sample compartment. Each accessory has unique setup parameters associated with it; many of them are already specified in the included experiment files. These parameters are configured through OMNIC. For more information about the available sample compartment accessories and basic installation instructions, see Accessories and Applications Modules.

Application Modules

Application modules, such as the Attenuated Total Reflection (ATR) module, allow integrated sampling with the spectrometer while used outside of the main sample compartment. Other modules are available for Near-IR, GC-IR, Raman, and FT-IR microscopy applications. Each module has an associated blue button, called a Touch Point, to conduct experiments directly from the iS50 spectrometer.

See Accessories and Applications Modules for information about the available modules for the iS50 spectrometer.
Spectrometer Components

This section describes the components of the Nicolet iS50 spectrometer.

See Accessories and Applications Modules for information about Smart Accessories, other sampling accessories, optional accessories, and system accessories; and also the optional ATR, GC-IR, Raman, and NIR application modules.

External Features

The following image identifies the components on the outside of the spectrometer. Some components are optional and may not be present on your spectrometer. Descriptions of the components follow the images.
Alternate Configurations

This image shows an iS50 spectrometer with a standard back cover (no ABX installed) and a standard right side cover (no ATR installed).

Dimensions

The following diagram shows the dimensions of the spectrometer as viewed from the top.
The following diagram shows the dimensions of the spectrometer as viewed from the front.

![Diagram of spectrometer dimensions from the front](image1)

The following diagram shows the dimensions of the spectrometer sample compartment.

![Diagram of spectrometer sample compartment](image2)
Power Switch

The power switch is located near the back of the spectrometer on the left side. This switch is used to turn the spectrometer on and off.

System LEDs

The two LEDs on the spectrometer located next to the power switch indicate system status and system scan activity.
System Status

The system status LED has two modes: **steady blue** to indicate the system is ready, and **blinking yellow** to indicate that an error has occurred. When the spectrometer is first turned on, this LED will blink blue.

System Scan

The system-scan LED blinks blue with each scan of the interferometer.

Sample Compartment Cover

The sample compartment is located at the front of the spectrometer and is accessible through a removable cover with an integrated hatch. The cover and hatch provide access to the sample compartment while keeping the spectrometer purge intact. The cover can be opened or removed for passing cables and tubes through the sample compartment, accessing the sample slide holder, changing accessories, and other tasks. The hatch is ideal for working with small samples and accessories and for changing windows and filters.

The sample compartment cover has two removable subpanels, about the size of a microscope slide, that can be removed to run additional cabling in and out of the sample compartment as needed.
Spectrometer Cover Locks

The spectrometer covers are equipped with several locks. There are four on the back cover, one on detector compartment cover, and one on the right side/ATR compartment cover.

**Note** Additional tools and steps are requires to remove the ATR cover. the iS50 ATR Module documentation that came with your system.

This is an image of a cover lock in the unlocked position:

![Cover Lock in Unlocked Position](image)

To lock the cover, use a flathead screwdriver to turn the lock counterclockwise until the two dots line up. To unlock, turn the screwdriver clockwise.

![Locked and Unlocked Cover Locks](image)

We also offer keyed cover locks. These function the same way but require a special key to permit access to the interior components. **Contact us** if you desire keyed locks.

Touch Points

The sampling action of the Nicolet iS50 spectrometer is controlled mainly by the Touch Points on the spectrometer, which initiate the configuration of the spectrometer and run experiments. Default experiment files are available for each button-sample point combination. There is a software equivalent of each button in OMNIC. Search for “Touch Points” in the OMNIC online help.
This image identifies the Sample Compartment Touch Point and the optional ATR Touch Point.

**Touch Point Functions**

Each Touch Point performs three functions:

1. **Communicate status**
   
The Touch Points communicate the spectrometer status with different states of illumination:
   
   - **Off**: The corresponding sample point is inactive.
   - **On**: The corresponding sample point is active.
   - **Blinking**: The spectrometer is being configured to use the corresponding sample point.

2. **Configure internal components**
   
   Pressing a Touch Point prompts the spectrometer to position the internal components into the correct configuration for an experiment. Specifically, the spectrometer moves the internal optics to create the beam path required by the experiment to be conducted with the corresponding sample point. This Touch Point blinks during configuration. When configuration is complete, the Touch Point stops blinking and stays on. Experiment configuration parameters are set up in OMNIC.

3. **Start sample collection**
   
   When the spectrometer is configured for an experiment, pressing a Touch Point starts the experiment using the corresponding sample point.
2 Operation
Spectrometer Components

Detector Compartment Cover

The detector compartment cover provides access to the detector compartment, where up to three detectors may be installed.

Liquid Nitrogen Fill Port

There is a liquid nitrogen fill port on the detector compartment cover that provides quick access to a cryo-cooled detector dewar. Open the gray cap for access to the dewar to fill it with liquid nitrogen.

External Beam Port

The external beam port on each side of the spectrometer is used to direct the infrared beam out of the spectrometer into an external module. The available external beam port windows are KBr, CsI, and CaF₂ (for the iS50 NIR).

See Research Module and Accessories and Applications Modules for information about how the external modules are connected to the external beam ports.

Emission Beam Ports (Optional)

The front emission beam port can be used to direct the collimated beam from an external emission source directly into the interferometer to bypass the aperture. The collimated beam mirror is available in aluminum only. This port also accepts focused beam input. This input is recollimated when it reaches the interferometer. The rear emission port allows the input beam to pass through the J-stop aperture and the filter wheel (if present). This permits filtering and the high resolution study of input sources.

Humidity Indicator

A humidity indicator is located on the top of the desiccant cap, located near the back of the instrument on the left side, next to the power switch. This indicator monitors the level of humidity inside the spectrometer. The indicator color communicates the desiccant status: blue means the desiccant is effective and pink or white means that the desiccant must be changed.
The indicators are useful when the spectrometer is in storage or otherwise not powered on. Humidity levels must be monitored whether the spectrometer is on or off to protect moisture-sensitive components.

**Note** It is recommended that the desiccant be changed once per year, even if the humidity indicator in the cap is blue.

See Desiccant, Checking Internal Humidity, and Replacing the Desiccant for more information.
Internal Features

This section describes the spectrometer features and options inside the spectrometer. Some components shown in the image are not present in all spectrometers.
Alternate Configurations

This image shows an iS50 spectrometer with an ABX installed and no ATR installed.

Sample Compartment

The sample compartment is located at the front of the spectrometer and is where a sample is located for collecting spectra for analysis. The sample can be mounted in a sample holder in the sample compartment itself, or in an accessory installed in the sample compartment. Several accessories for the sample compartment are available. See Accessories and Applications Modules for more information.

Accessory Accommodations

Inside the sample compartment are a number of connectors and ports for optional Smart Accessories, other sampling accessories, and system accessories. See Accessories and Applications Modules for more information.

Sample Compartment Windows

When the sample compartment cover or hatch is open, sample compartment windows block the introduction of water vapor and carbon dioxide into the spectrometer and keep the purge intact.
Automated Purge Shutters (Optional)

Automated purge shutters create a seal at the sample compartment wall openings to maintain internal equilibrium when the sample compartment windows are removed and the sample compartment is open.

Optical Filters

Optical filters can be placed in front of the windows for experiment purposes. See Installing an Optical Filter in the Sample Compartment. Optical filters can also be used in the aperture and filter wheel. See Installing an Optical Filter in the Filter Wheel (Optional).

Laser

The HeNe laser unit is accessed from the outside of the spectrometer at the back panel; the laser beam is directed into the spectrometer. The laser is a user-replaceable part. See Replacing the Laser for instructions.

Sources

Sources are components inside the spectrometer that emit infrared radiation that travels to the detector. The sources are installed on a fixed-mount unit that is specially tooled at each source position. This ensures that the correct source is installed in the correct position and in the correct direction. The electrical connection from the sources to the spectrometer are made automatically. Sources are replaced through the back cover of the spectrometer.

Two types of internal sources are available:

• IR
• NIR (white light)

This image shows the source mount with available sources in their respective positions and an optional Raman detector. An optional emission mirror is also shown.

There are beam ports available on the sides of the spectrometer that can accommodate external sources. See Emission Beam Ports (Optional).
Interferometer

A device that splits and then recombines an infrared beam. The output signal is an interferogram. Usually one beam passes through the interferometer’s beamsplitter, is reflected from the moving mirror and returns to the beamsplitter. The other beam is reflected from the beamsplitter and then is reflected from the fixed mirror and returns to the beamsplitter. The recombined beam exits the interferometer, passes through the sample and travels to the detector.

The type of interferometer installed depends on your spectrometer configuration:

- The Nicolet iS50 uses a standard linear-scan Vectra™ interferometer.
- The Nicolet iS50R uses the step-scan and linear-scan capable Vectra interferometer and the optional Vectra Piezo™ interferometer for phase modulation (PM).

Compartment for Optional ATR Module

The spectrometer supports a built-in, all reflective single-bounce ATR accessory with a single detector configuration. The ATR accessory is mounted in the right-side compartment near the front of the spectrometer. See the iS50 ATR Module documentation for more information.

Detectors

There is a dedicated DLaTGS detector installed in the fixed position. Two configurations are available: KBr (standard) and CsI, which includes either a KBr detector window or a CsI detector window. Fixed detectors are not user-replaceable.

The interchangeable-detector option comes with a motorized detector mirror and two aligned detector subplates (front and back). Up to two additional detectors can be installed in the detector compartment. The front subplate accepts room-temperature detectors only and the back subplate accepts both liquid-nitrogen-cooled detectors and room-temperature detectors. The middle position is for fixed detectors only. Interchangeable detectors are user-replaceable.
Access to the detectors is available through a removable cover to the left of the sample compartment. The detector compartment cover has a filling port for a standard nitrogen-cooled detector dewar. The detector compartment cover can be removed to exchange detectors. See Changing a Detector for instructions. Optional reflective optics can be acquired for the front detector compartment to direct the beam out of the spectrometer to the left, for detectors such as a bolometer.

**Room Temperature Interchangeable Detectors**

- DLaTGS detector with polyethylene window
- TE-cooled DLaTGS detector with KBr window
- PbSe detector with sapphire window
- Si detector with quartz window
- InGaAs detector for NIR
- TE-cooled InGaAs detector for NIR

**Liquid Nitrogen Cooled Interchangeable Detectors**

- MCT-High D* detector with CdTe window
- MCT-A detector with CdTe window
- Wide range MCT-B detector with KRS-5 window
- Liquid N$_2$ InSb detector with CdTe window
- Photoconductive 1x1mm$^2$, 175KHz TRS MCT with CdTe window
- Photovoltaic 0.5x0.5mm$^2$, 50 MHz TRS MCT with CdTe window
- Photovoltaic 1x1mm$^2$, 20 MHz TRS MCT with CdTe window
Beamsplitters

The iS50 spectrometer is generally equipped with one KBr beamsplitter, but there may be additional beamsplitters depending on the spectrometer configuration.

The beamsplitters that are available for the iS50 spectrometer are:

- KBr
- XT-KBr
- Quartz
- Solid Substrate
- CaF$_2$
- CsI (Only available with the fixed CsI configuration; it cannot be used in the ABX.)

Beamsplitter Compartment

The beamsplitter compartment hatch provides easy access to the beamsplitter compartment.
Beamsplitters are manually installed into and removed from the interferometer through this hatch. This is available only for systems without an optional ABX installed.

Beamsplitter Storage Area

The beamsplitter storage area is provided in a sealed and desiccated area near the back of the spectrometer, to the left of the interferometer. This storage area can be accessed through the beamsplitter compartment hatch. The beamsplitter storage area can hold two beamsplitters. This is available only for systems without an optional ABX installed.

See Storing a Beamsplitter in the Storage Compartment for more information.
2 Operation
Spectrometer Components

**Automatic Beamsplitter Exchanger (ABX)**

The optional iS50 ABX provides multi-range spectrometry without having to manually swap optics or remove the exchanger. When you select a configuration in OMNIC, the iS50 ABX loads the correct beamsplitter into the interferometer. See Using the iS50 ABX (Optional) for more information.

![Automatic Beamsplitter Exchanger (ABX)](image1)

**Aperture and Optional Filter Wheel**

The filter wheel can hold up to five optical filters. There is also one open position. The filter wheel accepts 1-inch diameter filters with thicknesses of 1 mm to 4 mm. Contact us for the filters that are available for your configuration. You can also collect spectra without a filter in the beam path. See Installing an Optical Filter in the Filter Wheel (Optional) for instructions.

![Aperture and Optional Filter Wheel](image2)
Optics

There are several optical components inside the spectrometer. Gold is the standard coating for optical mirrors, although Aluminum optics are an available option. The emission port and detector output port optics are available in aluminum only.

Source Mirror

Depending on your configuration, you will have either a fixed single position source mirror or a motorized quad-position source mirror.

Detector Mirror

Depending on your configuration, you will have either a single (top) detector mirror or a triple detector mirror.

ATR Mirror

If you have an optional ATR module, there is a motorized mirror in the spectrometer that moves into position to direct the beam into the ATR.

Passport Mirror

The Passport mirror is an optional, motorized mirror that can direct the IR beam out the left or right output port of the spectrometer. Available in gold and aluminum.

Aperture

The aperture is a variable-diameter opening device that controls the angular size of the infrared beam and, thus, controls the amount of radiation that reaches the sample and the optical resolution.

Polarizer

The optional IR polarizer controls the beam polarization can rotate the polarization angle over a range of 180 degrees.

Desiccant

Your spectrometer is protected from excessive humidity by a desiccant that is located inside the spectrometer on the left side next to the power switch, accessible through the round, dark-gray cover. If you have a purge kit, the desiccant is not needed unless you store or move the spectrometer. You may find that the system purges better when the desiccant is removed.

See Replacing the Desiccant for more information. To regenerate the desiccant, see Regenerating the Desiccant.
The Back Panel

There are several ports on the back panel of the spectrometer: five on the electronics module and three on the base. On the electronics module are an auxiliary signals port, two accessory ports, a computer port, and a DC power port. On the base of the spectrometer are a microscope accessory port, purge input port, and sample compartment accessory port.

Electronics Module

**Auxiliary Signals Port**

Connect components such as the remote start cable and the iS50R Hub using the Auxiliary Signals port. This port is also used by service personnel to check the spectrometer performance.

**Accessory Ports (Left and Right)**

Connect other components and application modules to the spectrometer using the two Accessory ports. There are two Accessory connectors available for connecting modules on either the left or right side of the spectrometer.

**Computer Port**

Connect the USB 2.0 cable from the system computer to the Computer port.

**DC Power Port**

Connect the spectrometer power supply unit into the DC Power port.

**NOTICE** Improper or unsafe cabling can cause damage to system hardware and may create a safety hazard. We are not responsible for damage or injury resulting from improper or unsafe cabling.

The power supply unit includes a power cable, a power supply, and a power cord. Connect the cable from the power supply into the DC Power port. Connect the power cord from the power supply into an electrical outlet or power strip.
Spectrometer Base

Microscope Touch Point Port

Connects an FT-IR microscope or other accessory that mounts on the right or left side of the spectrometer. Refer to the documentation that came with your microscope or accessory for connection instructions.

Purge In Port

Connects to a purge gas supply if your spectrometer includes a purge kit. See Installing a Purge Kit for instructions.

Sample Compartment Accessory Port

This port is used to connect the USB camera for the iS50 Raman sample compartment accessory directly to the computer. The connection is made by connecting a sample compartment accessory to the accessory connector inside the sample compartment. The accessory connector leads to the external USB port on the base of the spectrometer. A USB cable is connected from this external port to a USB 2.0 port on the computer. See Cabling An Accessory for more information.
Using Your Spectrometer

This section contains instructions that describe how to operate the spectrometer to perform basic tasks.

**NOTICE**  We recommend that you maintain seal and desiccation and/or purge your instrument at all times. Equipment damage due to failure to maintain seal and desiccation and/or purge is not covered by the warranty. If you have questions about this requirement, contact us.

Turning the Spectrometer On and Off

We recommend that you keep your spectrometer on at all times, unless the building is subject to power outages or you need to perform a service or maintenance procedure. Leaving the system on maintains thermal stability and gives you the most consistent results. If you power cycle the spectrometer, allow it to stabilize for at least 15 minutes, one hour for best results, before collecting spectra.

**Turning the Spectrometer on**

1. Turn on the spectrometer by pressing the power switch on the back of the instrument (I/O) to I.

   **Video: Turning the spectrometer on**

   When you turn on the spectrometer, the system status and system scan LEDs next to the power switch flash in various sequences as the system performs its diagnostic routines. When the routines are finished, the system status LED stops flashing and remains lit. The system scan LED will intermittently blink, indicating that the interferometer is scanning and working properly. See System LEDs for more information.

   If the system status LED continues to flash or does not light at all, turn the spectrometer power off and then back on. If this does not resolve the problem, see Troubleshooting for possible causes and solutions. If you cannot resolve the problem, contact us.

**Turning the Spectrometer off**

Press the power switch (I/O) to 0.

**Video: Turning the spectrometer off.**
2 Operation
Using Your Spectrometer

Opening the Sample Compartment

The sample compartment cover can be opened and removed. There is also an integrated hatch that provides access to the sample compartment.

Time needed: Five minutes or less

Tools needed: None

Cover

Video: Opening the sample compartment.

Hatch

To open the hatch, lift the cover up by the blue tab on the front of the hatch as shown:

Closing the Sample Compartment

Time needed: Five minutes or less

Tools needed: None

Cover

Video: Closing the sample compartment.

Hatch

Lower the hatch of the sample compartment down and towards you until it is closed.
Removing the Sample Compartment Cover

Time needed: Five minutes or less

Tools needed: None

1. Open the sample compartment cover.
2. Unlock the sample compartment cover and remove it.

Video: Removing the sample compartment cover.

Replacing the Sample Compartment Cover

Time needed: Five minutes or less

Tools needed: None

1. Make sure the back cover is installed and the locking mechanism is unlocked.
2. Insert the tab on the curved back edge of the sample compartment cover into the notch in the spectrometer cover behind the locking mechanism.
3. Align the sample compartment cover so that the ball joint on the cover can be inserted into the locking mechanism.
4. Press down on the curved back edge of the cover so that the ball joint is inserted as far as it will go. Be sure that the curved back edge of the sample compartment cover is flat against the spectrometer back cover.

5. Secure the sample compartment cover by moving the locking mechanism lever to the right towards the “locked” symbol.

Video: Replacing the sample compartment cover.

6. Close the sample compartment.

Removing the Back Cover (Non-ABX)

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.

- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

**Time needed:** Five minutes or less

**Tools needed:** Large flathead screwdriver

Video: Removing the back cover.

See Removing the ABX Cover if you have an ABX.
Replacing the Back Cover (Non-ABX)

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.
- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

**Time needed:** Five minutes or less

**Tools needed:** Flathead screwdriver

**NOTICE** Remove the desiccant before replacing the back cover. The netting around the desiccant can fray and make installing the cover difficult. Replace the desiccant through the black desiccant cap after the back cover is installed.

**Video:** Replacing the back cover.

See Replacing the ABX Cover if you have an ABX.

Opening the Beamsplitter Compartment Hatch

The beamsplitter compartment hatch is located in the back cover of the spectrometer (non-ABX).
1. Press the ridged tab on the edge of the hatch towards the back of the spectrometer to release it.

2. Lift the hatch to open.
**Closing the Beamsplitter Compartment Hatch**

1. Lower the hatch by the front edge until it is closed.

2. Press on the front edge of the hatch to secure it.

**Removing the ABX Cover**

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.

- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

**Time Needed:** Five minutes or less

**Tools needed:** Flathead screwdriver

1. Remove the sample compartment cover.

2. Remove the ABX cover.

   Video: Removing the ABX cover.
Replacing the ABX Cover

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.
- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

**Time Needed:** Five minutes or less

**Tools needed:** Flathead screwdriver

1. Remove the desiccant.

**NOTICE** Remove the desiccant before replacing the back cover. The netting around the desiccant can fray and make installing the cover difficult. Replace the desiccant through the desiccant cap after the back cover is installed.

2. Carefully lower the cover over the ABX and lock it using a flathead screwdriver.

   Video: Replacing the ABX cover.

3. Replace the desiccant.

4. Replace the sample compartment cover.

Installing the Standard Sample Holder

1. Attach the holder to a baseplate using a flat-head screwdriver and slotted screws.

2. Install the baseplate in the sample compartment.
If you are using separate Snap-In™ sample compartment baseplates for different accessories and sample holders, see Removing the Snap-In Baseplate. If your sample holder is mounted on a Smart baseplate, the Transmission E.S.P. experiment is automatically selected when you install the baseplate in the sample compartment.

To remove the sample holder, see Removing a Standard Sample Holder.

**Removing a Standard Sample Holder**

1. Remove the two screws that attach the sample holder to the baseplate with a flat-blade screwdriver.

2. Remove the sample holder from the baseplate.

   **Note** A blank baseplate should not be left installed in the sample compartment when other Smart accessories are installed, such as an ATR.

**Inserting a Sample into a Sample Holder**

The sample holder provided with your spectrometer is used for installing film samples, filters, and slide-mounted accessories in the beam path inside the sample compartment.

1. Open the sample compartment cover.

2. Slide the sample into one pair of slots in the sample holder.

   If the sample is not centered in the sample compartment, adjust the sample height. See Adjusting the Sample Height in a Sample Holder for instructions.
Adjusting the Sample Height in a Sample Holder

The infrared beam is centered in the sample compartment, approximately 3.5 inches above the baseplate. To adjust the vertical height of the sample, turn the adjustment screw in the sample holder. Turn the screw counterclockwise to move the sample up; clockwise to move the sample down.

Installing a Sample Compartment Filter in a Sample Holder

A sample compartment filter is installed in a sample holder the same way that a sample is. If a slide-mounted accessory support is currently installed in the slot you want to use, remove the support before inserting the filter. Replace the support when you are finished.

**Note** For information about filters mounted on the walls of the sample compartment, see Installing an Optical Filter in the Sample Compartment. See Using the Optical Filter Wheel (Optional) for information about using optical filters in the filter wheel.

1. Open the sample compartment cover.
2. Slide the filter into one pair of slots in the sample holder.
3. Adjust the height of the filter if necessary. See Adjusting the Sample Height in a Sample Holder, replacing the sample with the filter.
Installing a Sidewall Adapter

The sidewall adapters create a seal surface needed for some purged accessories. They provide a flat surface for the purge tube to sit tightly against. Cradles are located on the sidewalls of the sample compartment, next to the sample compartment window ports.

1. Open the sample compartment cover.
2. Slide a sidewall adapter into the cradle.

Using the Automated Purge Shutters (Optional)

Automated purge shutters are available for use when sample compartment windows are not being used. The purge shutters create a seal at the sample compartment wall openings to maintain internal equilibrium when the sample compartment is open. The normal default position is closed.

NOTICE Avoid damaging the purge shutters. Never move the purge shutters by hand. Always let OMNIC move the shutters.

The purge shutters are located just outside of the sample compartment, immediately adjacent to the sample compartment window ports. They are controlled through the OMNIC software on the Bench tab of Experiment Setup. You can set the shutter mode (manual or automatic) and the shutter delay (in seconds). See “Selecting the Purge Shutter Operation Mode,” “Operating Purge Shutters Manually,” or “Specifying a Delay for the Purge Shutters” in the OMNIC online help for more information.

Changing a Detector

Up to three detectors – two interchangeable and one fixed DTGS – can be installed the iS50 spectrometer at the same time. The interchangeable detectors are optional and are installed in the front and back positions of the detector compartment. The front detector position holds a room-temperature detector only. The back detector position holds either a room-temperature or a cryo-cooled detector. The fixed DTGS detector is a standard component and located in the middle position of the detector compartment. The fixed DTGS detector is not user-replaceable. Contact us if you suspect the fixed detector must be replaced.
Removing a Detector

CAUTION Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.

NOTICE Use static precautions when performing this procedure.

Detectors are sensitive to static electricity. To preserve the integrity of your detectors, leave them in their shipped configuration or packaging until you have reviewed the instructions for handling them.

Detectors contain printed circuit boards, which have components that can be damaged by static electricity. To protect the components, handle the detector assembly by the metal parts only and leave the detector in the protective packaging until it is ready to be installed.

Do not touch the window of the detector.

Time: Five minutes or less

Tools needed: Large flathead screwdriver, long Philips head screwdriver

❖ To Remove a Detector

1. Turn off the spectrometer.

2. Remove the detector compartment cover. Unlock the cover by inserting a large flathead screwdriver into the lock and turning it counterclockwise. Lift the cover off of the spectrometer.

3. Locate the two screws in the baseplate of the detector you want to remove. There is one screw located on each side of the detector; both room-temperature and cryo-cooled detectors use the same kinds of screws in their baseplates. These screws do not need to be
tightened for daily use, but should be for optimum performance. They must be tightened whenever the spectrometer is moved.

This image demonstrates unscrewing the screw for a cryo-cooled detector on the left and a room temperature detector on the right.

If the screws are tightened, unscrew them with a large flathead screwdriver until they are loosened. They will not come out of the detector baseplate.

4. Remove the detector. The detector is held in place by magnets on the bottom of its baseplate. Grasp the detector by its sides and carefully but firmly pull the detector straight up to remove it.

**NOTICE** The detector is a pre-aligned optical component. Use care when handling the detector; do not touch or breathe on optical surfaces. Fingerprints and moisture will degrade the optical path, may distort your data, and can permanently damage optical surfaces.

5. Store the detector.

**NOTICE** Detectors that are installed in the spectrometer can remain in place indefinitely as long as a dry internal atmosphere is maintained. Detectors that are not inside the spectrometer should be stored in a clean, dry area. DLaTGS detectors with CsI windows must be stored in a very dry atmosphere.
Installing a Detector

CAUTION Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.

NOTICE Use static precautions when performing this procedure.

Detectors are sensitive to static electricity. To preserve the integrity of your detectors, leave them in their shipped configuration or packaging until you have reviewed the instructions for handling them.

Detectors contain printed circuit boards, which have components that can be damaged by static electricity. To protect the components, handle the detector assembly by the metal parts only and leave the detector in the protective packaging until it is ready to be installed.

To Install a Detector

Time: Five minutes or less

Tools needed: Long Philips head screwdriver

1. Remove the detector compartment cover if installed. Unlock the cover by inserting a large flathead screwdriver into the lock and turning it counterclockwise. Lift the cover off of the spectrometer.

2. Locate the detector alignment pins and detector port inside the spectrometer. Depending on your detector, the alignment pins will be on either the spectrometer baseplate or on the detector baseplate.

This image shows the connections and baseplate of a cryo-cooled detector. The holes are in the detector baseplate and the pins are on the spectrometer baseplate.
3. Hold the detector above the detector compartment to align the pins with the holes. Align the connector on the detector baseplate with the detector connector in the spectrometer.

4. Lower the detector into place. The detector is secured with magnets in the spectrometer baseplate. Press firmly on the detector baseplate to be sure that the connector is properly seated.

**NOTICE** If you are planning to move or ship the spectrometer, use a flat-blade screwdriver to tighten the two screws. If you are not planning to move or ship the spectrometer, you do not need to tighten the screws.

5. Replace the detector compartment cover. Lock the cover by inserting a large flathead screwdriver into the lock and turning it clockwise.

6. **Turn the spectrometer on.**

7. Configure the detector in OMNIC.
To configure the detector in OMNIC

1. Choose an experiment in OMNIC.

2. Select the new detector.

   Make sure that the **Sample compartment** parameter is set to **Main**. The new detector name will appear in the **Detector** drop-down list.

3. Set the aperture for the new detector.

   For **DLaTGS** detectors, set the aperture to **100**. (They have a larger element and use a larger infrared beam.)

   For **MCT-A, MCT-B, InSb, PbSe** and **Si** detectors, set the aperture to **32**.

4. Align the spectrometer. (Collect > Experiment setup > Diagnostics tab > Bench Align)

**Note** Increased levels of water and carbon dioxide in spectra collected may appear immediately after the detector compartment has been opened. If this interferes with your data, wait several minutes and try collecting the spectra again.

### Installing a Legacy Detector

To install detector from a Nexus, 6700, or 8700 spectrometer, following the instructions on Installing a Detector. Then locate the bank of six switches labeled SW1 on the detector. Set them as shown:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>OFF</td>
</tr>
<tr>
<td>2</td>
<td>ON</td>
</tr>
<tr>
<td>3</td>
<td>ON</td>
</tr>
<tr>
<td>4</td>
<td>OFF</td>
</tr>
<tr>
<td>5</td>
<td>ON</td>
</tr>
<tr>
<td>6</td>
<td>OFF</td>
</tr>
</tbody>
</table>
Cooling a Detector

**WARNING** Avoid freeze burns. Liquid nitrogen is extremely cold and therefore potentially hazardous.

- Wear protective equipment and follow standard laboratory safety practices.
- To avoid hazardous contact with liquid nitrogen, make sure any dewar or container used to hold liquid nitrogen can do so safely without breaking.
- When filling the dewar, be careful not to contact the liquid nitrogen with your skin. Fill the dewar slowly. Cooling the detector too quickly may cause the dewar to rapidly boil off liquid nitrogen.

MCT and InSb detectors must be cooled with liquid nitrogen before use. The detector has a 750mL dewar with an insulating vacuum to contain the liquid nitrogen. The dewar can maintain its vacuum for several years. However, leaks are possible and will compromise the insulation effectivity of the dewar. See Maintaining Detector Dewars for more information. If the dewar leaks, contact us for repair information.

**Tools Needed:** Detector-fill funnel

**Time Needed:** 30 minutes or less

**To Cool a Detector**

1. Open the detector dewar cover and remove the plastic stopper.
2. Insert a funnel into the liquid nitrogen fill port of the detector dewar.
3. Slowly fill the detector dewar with liquid nitrogen through the funnel.
   
   Cool the funnel and funnel stem first: fill the funnel and let it drain completely into the detector two or three times. Always let the liquid nitrogen flow into the detector before adding more liquid nitrogen.

   A small amount of liquid nitrogen spillage will not harm the instrument, but do not overfill the detector or pour too quickly. Cooling the detector too quickly may cause the dewar to rapidly boil off or spill out excess amounts of liquid nitrogen.

   **NOTICE** Do not spill liquid nitrogen onto or near the detector window. Rapid cooling of the window's o-ring seal can cause the dewar to lose vacuum. Prolonged exposure to atmospheric pressure can damage the detector element. Always fill the dewar with the instrument cover in place.

   When the detector is nearly full, a small amount of liquid nitrogen will boil off.
   Approximately one liter of liquid nitrogen will be consumed in this process.

4. Let the vapor plume dissipate, replace the plastic stopper, and close the dewar cover.

   Allow at least 20 minutes for the detector to cool before use.
Using Beamsplitters

Beamsplitters are infrared optical windows that split a beam of light into two identical beams. The beams travel a pre-determined path inside the spectrometer and are then recombined. This recombined beam is directed through a sample and finally to the detector for analysis.

Beamsplitter and Detector Compatibility

A number of light sources, beamsplitters, and detectors are available for use in the Nicolet iS50 spectrometer. While you can change the beamsplitters and detectors, not all combinations are optimal. Also, some detectors can saturate (be overexposed) easily, and may require changing the aperture size or installing an energy filter.

There are two factors for selecting a beamsplitter-detector combination: compatibility and spectral range. Combinations are considered compatible if they provide a detector signal that is large enough to allow the beamsplitter to be aligned. This does not necessarily mean a particular combination will provide the maximum sensitivity range of each component.

Detector Specifications

This table shows the beamsplitter-detector combinations that perform best, those that are compatible, and those that are not compatible.

<table>
<thead>
<tr>
<th>Detector</th>
<th>Beamsplitter</th>
<th>Near-IR</th>
<th>Mid-IR</th>
<th>Far-IR</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Quartz</td>
<td>CaF2</td>
<td>XT-KBr</td>
</tr>
<tr>
<td>DLaTGS (KBr window)</td>
<td>x</td>
<td>OK</td>
<td>Best</td>
<td></td>
</tr>
<tr>
<td>DLaTGS (CsI window)</td>
<td>x</td>
<td>x</td>
<td>OK</td>
<td></td>
</tr>
<tr>
<td>DLaTGS (PE window)</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>DLaTGS ATR (proprietary window)</td>
<td>x</td>
<td>x</td>
<td>OK</td>
<td>Best</td>
</tr>
<tr>
<td>MCT-A</td>
<td>OK</td>
<td>OK</td>
<td>Best</td>
<td></td>
</tr>
<tr>
<td>MCT-B</td>
<td>OK</td>
<td>OK</td>
<td>Best</td>
<td></td>
</tr>
<tr>
<td>InSb</td>
<td>OK</td>
<td>Best</td>
<td>OK</td>
<td></td>
</tr>
<tr>
<td>PbSe</td>
<td>OK</td>
<td>Best</td>
<td>OK</td>
<td></td>
</tr>
<tr>
<td>Si</td>
<td>Best</td>
<td>OK</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>PbS</td>
<td>OK</td>
<td>Best</td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>InGaAs</td>
<td>OK</td>
<td>Best</td>
<td>OK</td>
<td></td>
</tr>
</tbody>
</table>
Best = Optimum beamsplitter-detector combination
OK = Compatible beamsplitter-detector combination
x = Incompatible beamsplitter-detector combination

* For visible spectroscopy, you will need a quartz beamsplitter, silicon detector, white light source and aluminum optics.

** Valid for room temperature and thermoelectrically cooled versions.

### Beamsplitter-Detector Combinations

This table lists the spectral ranges of compatible beamsplitter-detector combinations.

<table>
<thead>
<tr>
<th>Beamsplitter</th>
<th>Spectral Range (cm(^{-1}))</th>
<th>Detector</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quartz</td>
<td>25,000 - 8,600</td>
<td>Si(^\d)</td>
<td>White light</td>
</tr>
<tr>
<td></td>
<td>11,700 - 2,800*</td>
<td>MCT-A(^\d)</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,700 - 2,800*</td>
<td>MCT-B(^\d)</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,700 - 2,800*</td>
<td>High D* MCTA</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,500 - 2,800*</td>
<td>InSb(^\d),§</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>13,000 - 2,800*</td>
<td>PbSe</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>10,000 - 4,200*</td>
<td>TEC PbS (with SabIR)</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>12,000 - 3,800</td>
<td>InGaAs</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td>CaF(^2)</td>
<td>11,700 - 1,200*</td>
<td>MCT-A(^\d)</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,700 - 1,200*</td>
<td>MCT-B(^\d)</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,700 - 1,200*</td>
<td>High D* MCT-A</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,500 - 1,850*</td>
<td>InSb(^\d),§</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>13,000 - 2,000*</td>
<td>PbSe</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>10,000 - 4,200*</td>
<td>TEC PbS (with SabIR)</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>12,000 - 3,800</td>
<td>InGaAs</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>14,500 - 8,600</td>
<td>Si(^\d)</td>
<td>White light</td>
</tr>
<tr>
<td>XT-KBr</td>
<td>11,700 - 750</td>
<td>High D* MCT-A</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,000 - 600*</td>
<td>MCT-A(^\d)</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,000 - 400*</td>
<td>MCT-B(^\d)</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,000 - 1,850*</td>
<td>InSb(^\d),§</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,000 - 2,000*</td>
<td>PbSe</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,000 - 375*</td>
<td>DLaTGS-KBr</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td></td>
<td>11,000 - 375*</td>
<td>DLaTGS TEC</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td>Beamsplitter</td>
<td>Spectral Range (cm(^{-1}))</td>
<td>Detector</td>
<td>Source</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------</td>
<td>----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td></td>
<td>12,000 - 3,800</td>
<td>InGaAs</td>
<td>Polaris, white light</td>
</tr>
<tr>
<td>KBr</td>
<td>4,500 - 375</td>
<td>DLaTGS ATR</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>7,400 - 350</td>
<td>DLaTGS-KBr</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>7,400 - 750</td>
<td>High D* MCT-A</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>7,400 - 600</td>
<td>MCT-A‡</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>7,400 - 400</td>
<td>MCT-B‡</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>7,100 - 350</td>
<td>DLaTGS TEC</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>6,400 - 350</td>
<td>DLaTGS-CsI</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>4,500 - 375</td>
<td>DLaTGS ATR</td>
<td>Polaris</td>
</tr>
<tr>
<td>CsI^</td>
<td>6,400 - 200</td>
<td>DLaTGS-CsI</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>6,400 - 750</td>
<td>High D* MCT-A</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>6,400 - 600</td>
<td>MCT-A‡</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>6,400 - 400</td>
<td>MCT-B‡</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>6,400 - 200</td>
<td>DLaTGS ATR</td>
<td>Polaris</td>
</tr>
<tr>
<td>Solid Substrate**</td>
<td>700 - 50</td>
<td>DLaTGS-PE</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>700 - 20</td>
<td>Si Bolometer</td>
<td>Polaris</td>
</tr>
<tr>
<td></td>
<td>1,600 - 80</td>
<td>DLaTGS ATR</td>
<td>Polaris</td>
</tr>
</tbody>
</table>

* This spectral range reflects the combination of the ranges of the Polaris and white light sources, as well as the limits of the beamsplitter-detector combination. The range achieved using one of these sources will not be as broad as the total range shown.

** The Built-in ATR utilizes an extended range detector window. Coupled with the Solid Substrate beamsplitter, this provides operation from 80 cm\(^{-1}\) to 3500 cm\(^{-1}\).

† Si detectors can be used only with a white light (tungsten-halogen) source. Spectral range operation above 16,000 cm\(^{-1}\) requires aluminum optics in the spectrometer and the visible filter set or enhanced sample spacing (0.5).

‡ These detectors must be cooled with liquid nitrogen before use.

§ InSb detectors will not produce a signal under intense light. During installation and alignment, start with the smallest aperture setting.

^ CsI beamsplitters are extremely hygroscopic (sensitive to moisture).
Handling Beamsplitters

**NOTICE**  Avoid damaging the beamsplitters. Beamsplitters are very sensitive to moisture and humidity, and must always be stored in a desiccated or purged environment.

To preserve the integrity of your beamsplitters, leave them in their shipped configuration or packaging sleeves until you have reviewed the instructions for handling the beamsplitters. Store the beamsplitters immediately upon removal.

Beamsplitters are very delicate. Hold them only by the handle. Do not touch the mounting pads or breathe on the substrate.

A beamsplitter stored in the beamsplitter storage compartment or loaded in the optional iS50 ABX remains in thermal equilibrium with the system. These areas are under the same purge conditions as the main optics. As a result, you can use a stored or loaded beamsplitter immediately and immediately begin collecting data.

Mid-IR beamsplitters (for example, KBr and CsI) are very sensitive to moisture. If the spectrometer loses purge, remove any Mid-IR beamsplitters stored in the instrument and carefully place them upright or on edge in a desiccator.

If you have an iS50 ABX installed, see Using the iS50 ABX (Optional).

Using a Shipping Sleeve to Protect the Beamsplitter

The shipping sleeve that the beamsplitter came in can be used for extra protection when not being stored in the storage compartment or ABX.

**NOTICE**

- Avoid damaging the beamsplitters. Beamsplitters vary in their sensitivity to moisture and must always be stored in a desiccated or purged environment.

- To preserve the integrity of your beamsplitters, leave them in their shipped configuration or packaging until you have reviewed the instructions for handling the beamsplitters. Store the beamsplitters immediately upon removal.

- Beamsplitters are very delicate. Hold them only by the handle. Do not touch the mounting pads or breathe on the substrate.

Video: Using the protective shipping sleeve with a beamsplitter.

Manually Installing a Beamsplitter

**NOTICE**  The beamsplitter must be seated properly in the interferometer for the spectrometer to function correctly after you close the beamsplitter compartment cover.

The CsI beamsplitter is very fragile and extremely hygroscopic. We strongly recommend minimizing the handling of this beamsplitter.
1. Open the beamsplitter compartment hatch.

2. Turn the latch counterclockwise to open the interferometer.

3. Hold the beamsplitter by the handle as shown.

4. Slowly and carefully lower the beamsplitter into the interferometer. Turn the latch clockwise to secure it in the interferometer.

   Video: Manually installing a beamsplitter.

5. Close the beamsplitter compartment hatch.

OMNIC automatically recognizes beamsplitters that are installed manually into the beamsplitter compartment on Nicolet iS50 systems that do not include the ABX. There is no need to configure them.

**Manually Removing a Beamsplitter**

1. Open the beamsplitter compartment hatch.

2. Turn the latch counterclockwise to open the interferometer, grasp the beamsplitter by the handle, and carefully lift it out of the interferometer.

   Video: Manually removing a beamsplitter.

3. Place the beamsplitter into the storage compartment or insert it into a protective shipping sleeve and keep in a desiccated area.

**Storing a Beamsplitter in the Storage Compartment**

You can store two beamsplitters inside the beamsplitter storage compartment indefinitely. Since the storage area is within the spectrometer optics area, a beamsplitter stored here remains in thermal equilibrium with the system. This area is under the same purge or sealed and desiccated conditions as the main optics. As a result, you can install and use a beamsplitter and quickly begin collecting data.
2 Operation
Using Your Spectrometer

NOTICE

• Mid-IR beamsplitters (for example, KBr and CsI) are very sensitive to moisture. If the spectrometer loses purge, remove any mid-IR beamsplitters stored in the instrument and carefully place them upright or on edge in a desiccator.

• Do not store beamsplitters with iS50 ABX hangers (optional) attached. Remove the hanger from the beamsplitter before putting it into the storage compartment.

1. Open the beamsplitter compartment hatch.

2. Hold the beamsplitter by the handle as shown.

3. Insert the beamsplitter into the storage compartment.

   Video: Using the beamsplitter storage compartment.

4. Close the beamsplitter compartment hatch.

Using the iS50 ABX (Optional)

The optional iS50 ABX (Automatic Beamsplitter Exchanger) provides multi-range spectrometry without having to manually swap optics or remove the beamsplitters. When you select a configuration in OMNIC, the iS50 ABX loads the correct beamsplitter into the interferometer. A removable cover provides access to the iS50 ABX to add or remove beamsplitters.

The iS50 ABX can accommodate up to three beamsplitters at once and it is compatible with legacy on-axis beamsplitters. The iS50 ABX supports several types of beamsplitters: KBr, XT-KBr, solid substrate, CaF₂, and quartz.

NOTICE The iS50 ABX is not recommended for use with the CsI beamsplitter due to the extreme fragility of CsI.
The i550 ABX is located towards the back of the spectrometer and sits above the interferometer and is powered by the spectrometer.

**NOTICE** For proper ABX operation, the laboratory bench top must be level from both front to back and left to right.

**ABX Features**

The i550 ABX is not user-installable. [Contact us](#) to add this option or if you suspect you need replacement ABX.
Removing the ABX Cover

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.
- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

**Tools needed:** Large flathead screwdriver

1. Remove the sample compartment cover.
2. Remove the ABX cover.

   **Video:** Removing the ABX cover.

Replacing the ABX Cover

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.
- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

**Time Needed:** Five minutes or less

**Tools needed:** Large flathead screwdriver

1. Remove the desiccant.

   **NOTICE** Remove the desiccant before replacing the back cover. The netting around the desiccant can fray and make installing the cover difficult. Replace the desiccant through the black desiccant cap after the back cover is installed.

2. Carefully lower the cover over the ABX and lock it using a large flathead screwdriver.

   **Video:** Replacing the ABX cover.

3. Install the desiccant.
4. Replace the sample compartment cover.
Attaching a Hanger onto a Beamsplitter

Hangers are attached to the beamsplitters to hang them from posts on the ABX. They can be installed in only one way, which prevents the beamsplitter from being hung backwards in the ABX.

**Time Needed:** Five minutes or less

**Tools needed:** Small Philips head screwdriver

1. Place the beamsplitter in its protective shipping sleeve.
2. Unscrew the two screws on the hanger using Philips-head screwdriver. Remove the short screw. Leave the long screw in far enough to open the hanger and attach it to the handle.
3. Place the hanger onto the beamsplitter handle as shown.
4. Secure the hanger to the beamsplitter by tightening the two screws. The beamsplitter and hanger will fit tightly together as one component.

Removing a Hanger from a Beamsplitter

**Time Needed:** Five minutes or less

**Tools needed:** Small Philips head screwdriver

1. Place the beamsplitter in its protective shipping sleeve.
2. Unscrew the two screws on the hanger. Remove the short screw. Leave the long screw in enough to be able to free the hanger from the beamsplitter. Open the hanger. Carefully hold the beamsplitter handle and take it out of the hanger.

3. Store the beamsplitter immediately in a desiccated environment. You can leave it in its protective shipping sleeve to prevent damage to the optical surface.

**Installing a Beamsplitter into the ABX**

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.

- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

**CAUTION** Avoid pinch hazard. To prevent personal injury, keep hands free from moving parts.

There are pinch-point hazards at the top of the column where the posts meet the carousel. As the hanging post is raised, there are small pins that insert into the top of the post that rotate the beamsplitters. These pins will cause injury to hands and fingers if they are in the path of the rising posts. During operation, keep hands and fingers free from posts and pins.

**Time Needed:** 10 minutes or less

**Tools needed:** Large flathead screwdriver

1. **Attach a hanger to the beamsplitter** if you have not done so.

2. **Remove the sample compartment cover.**

3. **Remove the ABX cover.**

4. Put the ABX into the proper load position so that the post you want to hang the beamsplitter on is accessible in the front of the tower and is above the rounded notch in
the tray. In OMNIC, go to Collect > Experiment Setup > Configure > Configure Bench > Beamsplitters. Click Load next to the post position number. The posts will rotate until the selected post is in the load position.

5. Load the beamsplitter onto the carousel by hanging it on the post that is in the load position. Make sure the serial number label faces out and the label that identifies the beamsplitter type faces the ABX, as shown.

Video: Loading a beamsplitter into the ABX.

6. Set the beamsplitter type in the associated position from the drop-down boxes in the iS50 ABX Configuration window in OMNIC. Click OK. The ABX will load the beamsplitter into the interferometer.

For more information, see “How to Configure the iS50 ABX” in the OMNIC online help. After a brand new beamsplitter is installed it needs to be aligned in OMNIC.

Removing a Beamsplitter from the ABX

**WARNING** Avoid personal injury.
- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.
- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

**CAUTION** Avoid pinch hazard. To prevent personal injury, keep hands free from moving parts.
There are pinch-point hazards at the top of the column where the posts meet the carousel. As the hanging post is raised, there are small pins that insert into the top of the post that rotate the beamsplitters. These pins will cause injury to hands and fingers if they are in the path of the rising posts. During operation, keep hands and fingers free from posts and pins.

Tools needed: Large flathead screwdriver

1. Remove the sample compartment cover.
2. Remove the ABX cover.
3. Put the ABX into the load position. In OMNIC, go to Collect > Experiment Setup > Configure > Configure Bench > Beamsplitters. Click Load next to the post position that you want to remove the beamsplitter from. The ABX will unlock and lift the beamsplitter out of the interferometer and rotate it to the load position.
4. Remove the beamsplitter as shown in the video.
   Video: Removing a beamsplitter from the ABX

   NOTICE Do not attempt to remove a beamsplitter from any location other than the load position.

5. Set the beamsplitter type to None in the associated position from the drop-down boxes in the i50 ABX Configuration window in OMNIC. Click OK.
6. Optional: remove the hanger from the beamsplitter.
7. Store the beamsplitter immediately in a desiccated environment. You can insert it into a protective shipping sleeve to prevent damage to the optical surface.

Available Information About the i50 ABX in OMNIC

Once OMNIC is configured with the beamsplitter settings, you can obtain the following information about the i50 ABX:

- The number of beamsplitters available/loaded.
- The load positions of all beamsplitters, their types, and their ID numbers.
- The selected or active beamsplitter.
• A notification when a beamsplitter exchange is complete.
• The status of a beamsplitter exchange that did not complete.

Tasks You Can Perform in OMNIC

You can perform the following tasks in OMNIC:

• Determine whether an iS50 ABX is installed in the spectrometer.
• Assign the beamsplitter type to the corresponding position on the exchanger.
• Install a beamsplitter by position on the carousel. For example, OMNIC can insert the beamsplitter in Position 1 into the interferometer.
• Specify a beamsplitter to use by selecting it from a drop down box in Experiment Setup on the Bench tab.
• Park the beamsplitters.

Error Conditions and Failure Modes Reported by OMNIC

OMNIC reports the following error conditions and failure modes:

• Loss of power
• Recovery after loss of power
• Stuck beamsplitters
• Missing beamsplitters

❖ If You Receive An Error Or Failure Notification

1. Turn the spectrometer off.
2. Disconnect the power supply.
3. Remove the iS50 ABX cover.
4. Investigate the malfunction that the OMNIC software reported.
5. Verify that the instrument is completely level.
6. Take appropriate action to correct the problem. See Troubleshooting for possible causes and solutions.
Using a Light Source

The Nicolet iS50 spectrometer uses an IR source and a NIR (white light) source. Using OMNIC, you can select a source by changing the Source setting on the Bench tab of the Experiment Setup dialog box. This option lets you collect spectra in the Mid-IR to Far-IR range or in the visible to Near-IR range. The spectral range is determined by the source, beamsplitter, and detector being used. See Specifying the Correct Optical Velocity and Spectral Range and Collecting Data in the Visible Spectral Range.

Two light sources can be installed in the spectrometer at the same time. See Sources for more information. See Replacing the Light Source for information on how to install and remove sources. Spectrometers with the optional collimated accessory source can use an external source. See Using an External Source (Optional) for more information on using external sources.

Using the Validation/Attenuation Wheel

The Validation/Attenuation wheel contains energy screens and validation standards.

Energy screens prevent detector saturation and signal distortion by blocking a portion of the infrared energy. The Validation/Attenuation wheel automatically inserts an energy screen into the beam path to block out a portion of the energy at all frequencies of the infrared beam.

The Validation/Attenuation wheel comes with 30%T and 10%T energy screens and has an open position for collecting spectra without a screen in the beam path. The same wheel also includes the 1.5 mil polystyrene and NG11 Glass standards used for performance verification and validation.

See Using Energy Screens for more information.
Using the Optical Filter Wheel (Optional)

The filter wheel is used to control the spectral range of the infrared light by selectively reducing the amount of infrared light that reaches the detector by automatically inserting a filter into the beam path. This is particularly useful for studies of small spectral regions or for blocking noisy spectral regions that contain no data of interest. Energy from other regions does not reach the detector, thus improving the signal-to-noise ratio in the region of interest.

The filter wheel can hold up to five optical filters. (One position should be left empty.) Some filters are included with the filter wheel, depending on your configuration. The filter wheel accepts 1-inch diameter filters with thicknesses of 1 mm to 4 mm. Contact us for the filters that are available for your configuration. You can also collect spectra without a filter in the beam path.

The filters are configured in OMNIC in Experiment Setup for the module-accessory combination. The filter settings are combined with the beamsplitter, source, and detector to calculate the maximum spectral range. The filters are verified at the beginning of a collection and used for collecting backgrounds and samples.

See Using Optical Filters for more information. See Installing an Optical Filter in the Filter Wheel (Optional) for instructions for installing filters in the wheel.
Using the Internal Polarizer (Optional)

An optional automated polarizer automatically controls the orientation of the electric field vector of the IR beam entering the sample compartment. The polarizer is mounted in the focusing beam path in between the sample compartment and the sample compartment mirror. The polarizer can be moved in or out of the beam without breaking the bench’s desiccation seal.

This option is useful for performing polarization studies of thin films and other sample types. The polarizer can rotate 180 degrees at intervals of one degree. At 0 degrees, the electric field vector is oriented vertically and perpendicular to the sample compartment baseplate. It is made of ZnSe, which limits the low-end spectral range to around 650 wavenumbers. There is no analyzer, but you can use manual optics in the sample compartment.

In these experiments, a unique background is required for each polarization position used. For example, if you are going to collect spectra at 0 and 90 degrees, corresponding background spectra are required at 0 and 90 degrees.

Turn on the Polarizer Angle check box (located on the Bench tab of the Experiment Setup dialog box) to move the polarizer into or out of the beam path. When the check box is on, the Polarizer Angle text box is active. To set the polarization angle, enter any value from 0 to 180 in the Polarizer Angle text box. Use the up and down arrows to adjust the polarizer one degree at a time to optimize your signal.

See Using the Polarizer for more information.
Specifying the Correct Optical Velocity and Spectral Range

While a wide range of optical velocities are available for these spectrometers, some velocity settings cannot be used for collecting data at certain combinations of spectral range and resolution. For example, if you are collecting data over a spectral range above 7899 cm\(^{-1}\), optical velocity settings faster than 2.53 cm/s are not available.

**To Specify the Velocity and Spectral Range**

Set **Optical Velocity** and **Max Range Limit** and **Min Range Limit** on the **Bench** tab of the **Experiment Setup** dialog box.

**To Specify the Resolution**

Set **Resolution** on the **Collect** tab.

**Note** When you switch to a different detector or beamsplitter, OMNIC automatically resets the default spectral range in the **Experiment Setup** dialog box. Be sure to check the range and set the velocity to a value that is appropriate.

Collecting Data in the Visible Spectral Range

The ability of the spectrometer to collect data is affected by the detector-beamsplitter combination and any energy screens or optical filters being used. You must also have aluminum mirrors in your spectrometer to collect visible spectra; gold absorbs strongly in the visible range making it unsuitable. For example, a quartz beamsplitter, a silicon detector, and a white-light source extends the sampling range to 27,000 cm\(^{-1}\).

Since silicon detectors are very sensitive, using an energy screen or bandwidth-limiting filter can help prevent the detector from becoming saturated during the experiment. The following table lists some spectral bands in the extended spectral range and the filter that should be used to obtain data in each range. Typical aperture and gain settings for experiments in each range are also listed. The **Aperture** and **Gain** settings are located on the **Bench** tab in the **Experiment Setup** dialog box.

<table>
<thead>
<tr>
<th>Spectral Range</th>
<th>Filter</th>
<th>Aperture</th>
<th>Gain</th>
</tr>
</thead>
<tbody>
<tr>
<td>15,500 - 9,000 cm(^{-1})</td>
<td>Red filter</td>
<td>32</td>
<td>1</td>
</tr>
<tr>
<td>23,000 - 16,000 cm(^{-1})</td>
<td>Broad-band blue filter</td>
<td>100</td>
<td>8</td>
</tr>
<tr>
<td>26,000 - 21,000 cm(^{-1})</td>
<td>Narrow-band blue filter</td>
<td>100</td>
<td>8</td>
</tr>
</tbody>
</table>

Use these filters and settings as a starting point and vary them as required by the experimental conditions. See **Using the Optical Filter Wheel (Optional)** for more information.
The optical filter wheel and Validation/Attenuation wheel can automatically move a filter or energy screen into the beam path before collecting data. See Using the Optical Filter Wheel (Optional) and Using the Validation/Attenuation Wheel for more information.

**Note** A system with Aluminum optics is required to collect data in the visible range.

See “Specifying the Spectral Range” in the OMNIC online help for more information.

### Using an External Source (Optional)

You can use an external light source with your spectrometer. The available external sources are the apertured external source and the collimated external source.

One external source accepts a collimated beam that then passes through the J-stop or aperture, providing the potential for stray light rejection and high resolution. This light also passes through the filter wheel.

The other external source travels to the interferometer in a collimated beam. The beam comes in through the left- or right-side beam-output port and does not pass through the aperture. This option uses a separate motorized mechanism to direct the collimated beam into the interferometer. Ensure your OMNIC software is configured to recognize this type of source. With the left side Emission source, this collimated beam can be directed out of the spectrometer only to the right side or to the sample compartment. The emission beam mirrors are available in aluminum only.

See “How to Configure a Focused External Source” in the OMNIC online help for configuration information.
Conducting an Experiment

This section describes the process of conducting basic experiment in the sample compartment. This process may differ from experiments you perform. The most commonly used hardware configuration for mid-IR experiments is a KBr beamsplitter, an IR source and a DLaTGS detector. You may need to change the settings of the experiment if your hardware configuration is different.

**Note** If you have a dedicated system that uses a software package other than OMNIC, skip this section. See the documentation that came with your dedicated system for instructions on using that software.

Preparing the Spectrometer to Collect Spectra

Before you collect spectra, perform the following tasks:

- Turn the spectrometer on.
- Check the purge.
- Check the desiccant.
- Check the detector (cryo-cooled only).

Checking the Purge

If your spectrometer is purged, but you must verify the pressure and flow rate settings for your system, see Setting Purge Gas Controls. If you purchased the sealed and desiccated option, see Checking the Desiccant.

**WARNING** Avoid explosion hazard. Never use a flammable, combustible, or toxic gas to purge this instrument. The purge gas must be free of oil and other reactive materials. Heat from the source or from laser absorption may ignite flammable gases or reactive materials in purge gas. Use only dried air or nitrogen to purge your instrument.

We recommend that you leave the purge on at all times. This keeps the spectrometer free of undesirable gases, protects the optics, and improves the system’s thermal stability.

See Installing a Purge Kit for information about installing purge equipment and setting the controls for the first time. Checking and Changing the Purge Gas Filter contains information about inspecting and replacing the purge filter.

The purge in the sample compartment comes from the main spectrometer through the open windows if removed and a self-connecting leak-free mechanism. This purge line comes from a bypass at the input of the purge port of the main spectrometer.
Checking the Desiccant

If your spectrometer is sealed and desiccated, the desiccant is located towards the back of the spectrometer on the left side. The desiccant protects the beamsplitter and other optical components by reducing the amount of water vapor inside the spectrometer. See Replacing the Desiccant for instructions on how to change the desiccant.

Check the round blue indicator on the desiccant compartment cap once a month. Change the desiccant if the indicator has turned pink or white. Keep all covers closed tightly while the spectrometer is in storage.

Checking the Detector

If you have an MCT or InSb detector, it must be cooled with liquid nitrogen before you use it to collect data. See Cooling a Detector for instructions.

Collecting a Spectrum

To collect a sample spectrum, you must first collect a background spectrum. This background spectrum measures the response of the spectrometer without a sample in place. Once you have the background spectrum, you can collect a spectrum with a sample in place. The sample data is then ratioed with the background data, which is the process of dividing the sample spectrum by the background spectrum. Ratioing removes the effects caused by the instrument and atmospheric conditions so that the peaks in the final spectrum are solely for the sample.

Here is a typical mid-IR background spectrum:

To obtain good results, collect a new background every four hours. You can obtain the best results by collecting a new background for each sample, but this is usually necessary only if you are running quantitative experiments. For most applications, you don’t need to collect a new background spectrum for each sample spectrum if parameters have not changed.

A number of experiments are included with OMNIC for performing various data collections. The parameter settings for collecting spectra are stored in the experiment files. These settings are loaded when you select an experiment from the Experiment drop-down list box. You can also use Experiment Setup to set up and save your own experiments, or to check or change the parameter settings after you select an experiment.
Additional experiments that do not initially appear in the Experiment drop-down list are also available. Click Open in Experiment Setup to choose an experiment. The experiment will appear and remain in the Experiment drop-down list.

See the “Collecting a Spectrum” tutorial (in Learning OMNIC) for more information.

Collecting the Background Spectrum

1. Open the sample compartment hatch to make sure the sample compartment is empty. Remove any sample from the sample holder.

   If your spectrometer is purged, open the hatch, remove the sample, close the hatch and wait 1 minute before choosing OK.

   If your spectrometer is sealed and desiccated, open the hatch, remove the sample, close the hatch and choose OK.

2. Select an experiment in OMNIC. (In this example, the Default - Transmission or Transmission E.S.P. experiment is used. This experiment is suitable for most applications.)

   Click the down-arrow button on the Experiment drop-down list box located just below the menu bar of the main OMNIC window. Select Default - Transmission (or Transmission E.S.P. if present).

3. Press the Touch Point next to the sample compartment.

   (You can also click the Collect Sample button in the toolbar or choose Collect Sample from the Collect menu in OMNIC.)

   The Collect Sample window with the default name of the sample spectrum appears.

4. Press the Touch Point to accept the default name, or enter a new name in the text box and choose OK. A message appears telling you to prepare to collect a background spectrum.

5. Press the Touch Point (or press Enter) to start data collection.

   A background spectrum appears in the Collect Sample window. The spectrum is updated as data is collected.

   When the data collection is complete, a message appears telling you to prepare to collect the sample spectrum.
Collecting the Sample Spectrum

1. Install a sample through the hatch into the sample holder.

   If your spectrometer is purged, wait 1 minute before continuing for equilibrium to re-establish.

   If your spectrometer is sealed and desiccated, equilibrium is maintained and you do not have to wait.

2. Press the Touch Point (or choose OK) to begin collection.

   As data is collected, the sample spectrum in the Collect Sample window is updated. The progress of the collection is indicated by the gauge below the spectrum, as shown.

   ![Gauge](image)

   The number of scans collected and the total number of scans for the collection are displayed to the right of the gauge.

   When data collection is finished, you may see a message asking if you want to add the spectrum to a spectral window.

   **Note** If Collect To A New Window is selected in the Collect options (available through Edit Options in the Edit menu), the spectrum is automatically placed into a new spectral window.

3. Choose from one of these four options:

   - Choose OK to add the sample spectrum to the spectral window.
   - Choose No to end the procedure without saving the spectrum.
   - Choose More Scans to return to the Collect Sample window. You can collect more scans with the More button.
   - Choose View Collect Status to display information about the collection, including any problems that occurred.

Saving the Spectrum

1. Click the spectrum to select it.

2. Choose File > Save or File > Save As.

3. Enter a filename (such as POLY.SPA) following the directory path in the File Name box.

   Example: C:\My Documents\OMNIC\Spectra\POLY.SPA

   The default directory path for saving files is set on the File tab of the Options dialog box, available through Options in the Edit menu.

4. Choose OK.
Improving the Quality of Your Spectral Data

If you are using the spectrometer for quantitative analysis or other demanding applications, precision and accuracy of your spectra is very important. For these types of applications, it is important that the spectra you collect have high-wavelength precision. This means that the frequency-axis (X-axis) location of peaks in a spectrum is consistently reproducible and within IUPAC (International Union of Pure and Applied Chemistry) published specifications.

Your spectrometer must respond linearly to these samples; absorption band intensity must be directly proportional to the number of molecules subjected to the light beam. As the number of molecules in the beam increases, the detected absorbance signal also increases at a consistent rate. System Performance Verification and ValPro are tools that are available to provide confidence that your Nicolet iS50 spectrometer is performing at or better than regulatory requirements.

If you are studying samples that produce small spectral peaks or have weak spectral features, or if you are looking for small changes in your samples, make sure the signal-to-noise ratio is high enough to distinguish spectral features from the noise that is present in all experimental data. This prevents the signals that contain spectral information from being lost among the signals generated by the random movement of electrons, building vibrations, light source fluctuations and other sources. See Improving the Signal-to-noise Ratio for more information.

Improving the Linearity and Photometric Accuracy

Some detectors, such as PbSe, Si, MCT-A and InSb detectors, are highly sensitive. They can become saturated or produce a distorted (non-linear and photometrically inaccurate) signal if the light energy is too intense or the detector gain is too high.

When using a high-sensitivity detector, look at a single-beam spectrum in the low-end region around 600 to 375 cm\(^{-1}\). There will be a straight line very near 0 intensity units. Typically, the distance from 0 to the baseline is less than 1% of the spectrum's maximum intensity value.

If the detector is saturated, false energy will appear in the low-end region of the spectrum. Also, the distance from the baseline to 0 may be greater than 20% of the spectrum's maximum intensity value.

**Note** The maximum intensity of a mid-IR single-beam spectrum is typically found near 2,000 cm\(^{-1}\).

The distorted signal may cause problems with photometric accuracy. For reliable quantitative data, the sample and background interferograms must be about the same size. Scattering samples and very dense samples produce very small signals that, when compared with much larger background signals, can distort quantitative data. Check the background and sample interferograms for substantial differences in size. Photometric accuracy may be affected.
Changing the Aperture Setting

The aperture is a variable-diameter opening device that controls the angular size of the infrared beam and the amount of radiation that reaches the sample. Using the aperture has these advantages:

• More sensitive detectors can be used.
• It helps prevent infrared energy saturation, so the response of the detector is more linear.
• It improves wavenumber accuracy and resolution by acting as a point source of infrared radiation.

The larger the aperture used, the better the signal-to-noise ratio of the collected data is. The smaller the aperture used, the better the stability and accuracy is. Smaller apertures are needed for high-resolution experiments.

DLaTGS detectors can accommodate most of the energy from the source, which means you can use a large aperture size. Detectors that require cooling with liquid nitrogen are very sensitive and require a small aperture size or the use of an energy screen.

Note: The aperture parameter setting determines the area of the aperture opening. The light energy is proportional to the aperture area. The iS50 spectrometer is designed such that an aperture setting of 100 will image the IR beam to completely fill the standard detector element. Lower settings will underfill the detector to help prevent saturation. It is recommended to set the aperture at or below 100.

The following table lists recommended aperture settings for different detectors with the appropriate energy screen installed. The settings in the table are based on the size of the DLaTGS detector elements and maximize the amount of infrared energy that reaches the sample. To correct linearity and photometric accuracy problems, you can reduce the setting, but you will decrease the signal-to-noise ratio.

<table>
<thead>
<tr>
<th>Detector</th>
<th>Aperture Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>DLaTGS</td>
<td>100</td>
</tr>
<tr>
<td>MCT-A, MCT-B, InSb, PbSe, Si, InGaAs</td>
<td>32</td>
</tr>
</tbody>
</table>

In the OMNIC online help, find “aperture” in the Index and go to “Setting the aperture size” for information about changing the aperture setting.

Using Energy Screens

Energy screens help prevent detector saturation and signal distortion. The Validation/Attenuation wheel moves a screen into the beam path before collecting data to block out a portion of the energy at all frequencies of the infrared beam. If your experiments deal with information from a broad range of frequencies, these screens may be the best way to
reduce the light level. Your system includes an Validation/Attenuation wheel with two energy screens (30%T and 10%T). (The Validation/Attenuation wheel also has two fixed validation standards (1.5mm polystyrene and NG11 Glass standards) used for performance verification and validation.)

This table shows the percentage of the infrared energy that each screen passes and the detectors typically used with each screen, as a starting point for correcting linearity problems.

<table>
<thead>
<tr>
<th>Screen</th>
<th>% Transmitted*</th>
<th>Detectors Typically Used With Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>100</td>
<td>DLaTGS</td>
</tr>
<tr>
<td>A</td>
<td>30</td>
<td>MCT-A</td>
</tr>
<tr>
<td>B</td>
<td>10</td>
<td></td>
</tr>
</tbody>
</table>

* These are nominal values that may vary due to diffraction and detector variations.

To correct for photometric accuracy, you may need to use a screen that transmits less infrared energy. With corrections for photometric accuracy, you will notice some reduction in the signal-to-noise ratio but will obtain more reliable quantitative data. Generally, the signal-to-noise ratio reduction is less than the signal intensity.

When you use energy screens, use the same screen for the background and sample collections for the best results. See Using the Validation/Attenuation Wheel for more information.

**Using Optical Filters**

Bandwidth-limiting filters improve the signal-to-noise ratio of the data and also prevent detector saturation by selectively transmitting energy to the detector. They are either installed in the sample compartment or in the optional Optical Filter Wheel. This wheel automatically moves a filter into the beam path before collecting data. See Using the Optical Filter Wheel (Optional) for more information.

**Using the Polarizer**

The IR-beam is randomly polarized; some polarization is caused by reflections, but generally the beam is unpolarized. The optional IR polarizer controls beam polarization and permits rotation of the polarization angle by at least 90 degrees. This can be very effective in studies of oriented films.

**NOTICE** Do not clean the polarizer. The polarization is provided by a very sensitive surface film that can be damaged or removed easily and become irreparable.

Reflections subsequent to passing the polarizer may scramble the beam polarization. See Using the Internal Polarizer (Optional) for more information.
Improving the Signal-to-noise Ratio

If you primarily analyze qualitative data, you may wish to optimize the system for a better signal-to-noise ratio. This can be particularly important when working with scattering samples and samples that absorb more infrared energy. These samples produce smaller signals that can be “lost” in the noise.

There are several ways to improve the signal-to-noise ratio. The most commonly used method is to increase the number of scans. This both reduces the noise level and makes small absorptions easier to distinguish. You can also improve the ratio by reducing the resolution, such as going from a 2 to an 8 wavenumber resolution setting.

Other methods are to increase the aperture size, use an energy screen that transmits more light, or use no screen at all. In this case, the resulting spectrum might be distorted and accuracy and stability could be reduced. Checking the single-beam baseline in the region below the low-end cutoff will give you a rough idea of how much distortion is occurring. If the distance from the baseline to 0 is more than 15% of the spectrum's maximum intensity value, you may have difficulty reproducing the results.

**Note** If the distance from the baseline to 0 is greater than 20% of the spectrum's maximum intensity value, your detector electronics may be overloaded. Contact us for assistance.

Improving the Resolution

If you want to achieve higher resolution, you may need to use a smaller aperture setting and an energy screen that transmits more light, or no screen at all to transmit the most light. Your spectroscopy software will automatically change the aperture setting if a smaller beam size is required. Be aware that the smaller beam size will reduce the signal-to-noise ratio.

In the OMNIC online help, find “aperture” in the Index and go to “Setting the aperture size” for information about changing the aperture setting.

System Performance Verification

The performance of your spectrometer is continuously monitored by the System Performance Verification (SPV) features in OMNIC. SPV performs the following tasks:

- Performs ASTM tests to verify your spectrometer’s performance
- Defines system suitability tests that are specific to your application
- Monitors data collection
- Notifies users when a test is out of date
- Implements complete, automated validation with the optional ValPro™ Qualification software
Using the OMNIC Software Suite to Process Data

The following software is available for your spectrometer:

- **OMNIC**: A full-featured spectroscopy software application for collecting, processing and analyzing FT-IR data.

- **OMNIC Specta™**: Enhances the features and procedures to analyze unknown samples. This software includes a 9,000 compound spectral database and features for managing a local copy of this database or “library.” A multi-component search feature identifies the spectra of mixtures and TGA-IR vapor phase samples.

- **TQ Analyst**: Provides an extensive suite of chemometrics features to identify raw materials, perform quantitative analysis, and take spectral measurements. (Basic quantitative analysis tools of TQ Analyst are included in the OMNIC software.)

- **OMNIC Series**: Adds a Series menu that provides tools for collecting and processing time series data, including rapid scan or kinetics data. This menu is used with the iS50 GC-IR interface, the TGA-IR interface, and the iS50 Raman module.

- **OMNIC for Raman**: Adds a menu to the OMNIC software with tools for collecting and processing data with the iS50 FT-Raman.
Accessories and Application Modules

This section covers the dedicated application modules and sampling accessories available for the Nicolet iS50 spectrometer. Brief descriptions of the types of sampling and system accessories available for the Nicolet iS50 spectrometer are provided below. Complete descriptions and operating instructions are included with the accessories.

Dedicated application modules allow integrated sampling with the Nicolet iS50 spectrometer while used outside of the main sample compartment. Each module has an associated blue button, called a Touch Point, to conduct experiments right from the spectrometer. The following modules are available:

- iS50 AEM (Auxiliary Experiment Module)
- iS50 ATR Module
  - Tips for ATR Sampling
- iS50 NIR Module
- iS50 Raman Module
- iS50 GC-IR Module

See the documentation that came with your system for user guides for these modules.

Smart Accessories

A variety of Smart Accessories are available for the Nicolet iS50 spectrometer. Nicolet FT-IR spectrometers identify each Smart Accessory as it is installed and set the software parameters for data collection. A series of spectral quality checks are performed to ensure that the accessory is installed and operating correctly.

General instructions for installing accessories are available in Installing Accessories. Instructions for installing, operating and maintaining each Smart Accessory are provided in their respective documentation. To start a Smart Accessory tutorial, click Sampling Techniques in the Help menu and then click the accessory name, or search for it in the Help Topics. All Smart Accessories have high stability through permanently aligned optics, high performance specifications, and tight rapid-purge sealing from the use of a sealed purge tube.
Smart ARK™ – This is a multi-bounce, horizontal Attenuated Total Reflection (ATR) accessory for the analysis of powders (flat plates) or liquids (trough plates). Excellent sensitivity coupled with easy cleaning make this an ideal process and analysis accessory.

Smart Collector™ – Diffuse reflection enables analysis of highly light-scattering solids that are difficult to analyze using transmission techniques. This method is also useful when the sample, usually a powder, must be analyzed without modification.

Smart Diffuse Reflectance – The diffuse reflection technique is used to analyze highly light-scattering solids that are difficult to analyze using transmission techniques. The technique is also useful when the sample, usually a powder, must be analyzed without modification. This accessory lets you analyze a wide variety of sample types and features integral sample cups for convenient, fast sampling.

Smart Integrating Sphere – The Smart Integrating Sphere is a highly efficient collector of diffuse scattered radiation. Light enters the integrating sphere from the bottom. The light then strikes the sample and is diffusely reflected. The reflected light is collected by the sphere and directed onto the detector. The optional sample spinner allows a wide area from inhomogeneous materials, like pellets or powders, to be analyzed.

Smart iTR – The Thermo Scientific Smart iTR is an ultra-high-performance, versatile ATR sampling accessory that eliminates sample preparation while delivering exceptional throughput. The Smart iTR can be equipped with various crystals to handle a wide variety of sample types.

Smart SAGA™ – This advanced accessory is designed for the analysis of thin films on reflective substrates. The 80-degree angle of incidence for this reflection-absorption accessory allows sensitive measurements of films as thin as 0.1 nm.

Smart OMNI-Sampler™ – This single-reflection ATR accessory features a spherical crystal to measure a wide variety of sample types. The tower design automatically applies the optimum pressure while protecting the crystal. The accessory is ideal for analyzing very small samples or sample areas and provides high reproducibility.

Smart OMNI-Transmission™ – This easy-to-install transmission accessory is used to sample liquids, gases, and solids using a wide variety of transmission cells and infrared cards.

Smart Orbit™ – This single-reflection ATR accessory features a durable diamond crystal and a swivel pressure tower that ensures consistent pressure from sample to sample. This accessory is used to perform analyses from the near-IR to the far-IR.

Smart Performer™ – This single-reflection ATR accessory features a horizontal sampling surface for collecting high-quality spectra with minimal sample preparation. This accessory uses a wide variety of low-cost crystals that are easy to install and remove.

Smart Refractor™ – This top-loading accessory is designed for fast analysis of coatings on reflective substrates using the grazing angle specular reflection technique.
4 Accessories and Application Modules

Other Sampling Accessories

Smart SplitPea™ – This horizontal ATR microsampling accessory is designed for fast analysis of solids, liquids, and powders. It is ideal for analyzing hard materials, small samples or samples where only minute quantities are available.

Smart Golden Gate™ – This is a horizontal, single-reflection ATR accessory that features an extremely durable diamond crystal. It handles a wide range of sample types, including hard or brittle solids, corrosive liquids, and hard powders.

Smart MIRacle™ – This is a single-reflection horizontal ATR accessory with exceptional throughput and sensitivity. It can use several crystal types and has a micrometer screw for precise control of applied pressure.

In the OMNIC online help, find “accessory” in the Index and go to “Specifying the accessory” for instructions for setting up and saving experiments for custom accessories.

Other Sampling Accessories

You can install many different, non-Smart sampling accessories. After you install an accessory, you may have to align it. Instructions for aligning the spectrometer and an accessory are available in Maintenance, as well as in the documentation for the accessory.

Some accessories fit into the sample compartment and require that you remove the Snap-In baseplate first. See Removing the Snap-In Baseplate for instructions.

**Note** Additional Snap-In sample compartment baseplates are available for use with each accessory to make changing them easier and faster.

Contact us to order any of the following sampling accessories.

Custom Accessory Baseplate – You can use this Smart baseplate to mount an accessory you have built or purchased from another manufacturer. When you install the accessory and baseplate in the sample compartment, the system automatically selects the Custom Accessory experiment. It will allow you to select from the experiments you have saved for the baseplate, if applicable.

Foundation Series – The innovative modular design of this accessory family provides access to several sampling devices that use a common base. This allows experimental flexibility at an economical price. Available techniques include ATR, diffuse reflection, specular reflection, transmission, and fiber optics.

Gas Cells – A variety of short- and long-pathlength gas cells are available. Cells include built-in transfer optics that fit into your spectrometer. The cells are suitable for use in both ambient and elevated temperature conditions. Gas cell heating, transfer optics purge, gas manifold, and sample window options are available to accommodate a variety of sample gases and sampling conditions.
Near-IR Heated Cuvette Holder E.S.P. – This accessory is designed for analyzing samples that require a constant or elevated temperature to obtain reproducible near-IR results. You can use it to analyze liquids, gels, and solids with low melting points, such as waxes.

PAC 300 Photoacoustic E.S.P.™ – Photoacoustic spectroscopy (PAS) is a powerful technique for the nondestructive spectroscopic analysis of solid samples of all types. PAS is particularly applicable to powders (including dark, highly absorbent samples), polymer pellets, beads, and sheets and films. The PAC 300 Photoacoustic E.S.P. accessory is fully integrated with the spectrometer and computer. It automatically selects an OMNIC experiment, draws power right from the spectrometer, and includes an online tutorial.

Specular Reflection – Specular reflection provides a nondestructive method for measuring surface coatings without sample preparation. It can be used to analyze surface-treated metals, paints, semiconductors, and resin and polymer coatings. Specular reflection accessories can be installed in the spectrometer sample compartment.

Transmission E.S.P.™ Accessory – Transmission is the oldest and most efficient sampling technique in FT-IR spectroscopy and can be used for sampling liquids, gases, and solids. A variety of cells and sample holders are available for transmission analysis. These accessories can be mounted in the spectrometer sample compartment. Thermo Scientific E.S.P. (Enhanced Synchronization Protocol) technology provides continuous communication between the accessory and OMNIC to ensure that the accessory is operating correctly. This accessory, or the Validation/Attenuation Wheel (described in the next section), is required for using an NPL or serialized polystyrene standard for validation with Thermo Scientific ValPro software.

TRS Kit – The Time Resolved Spectroscopy (TRS) kit includes a fast transient data-acquisition card, a high-speed photovoltaic MCT detector, and the OMNIC SST software with TRS experiments software package to perform a variety of time-resolved experiments. Time-resolved measurements to 10 nanoseconds are possible.

Other Accessories

Additional accessories are available for your spectrometer. Contact us to order any of the following accessories.

iS50 ABX – The Automatic Beamsplitter Exchanger (ABX) switches beamsplitters in and out of the interferometer without requiring any manual intervention from the user. The exchanger can hold up to three different beamsplitters and is controlled and configured with OMNIC.

Automatic Sample Wheel – This accessory holds multiple samples and rotates them into the beam path for data collection. The sample wheel is commonly used to measure multiple polymer or pressed-powder samples.

Bolometer – This is a far-infrared, highly sensitive thermal detector. The detector is mounted on the left side of the spectrometer using transfer optics to focus the beam optimally. The bolometer requires liquid helium for cooling.
Validation/Attenuation Wheel – The Validation/Attenuation wheel is used with the ValPro software to validate the performance of the spectrometer. The wheel automatically moves standard samples into the beam path at the appropriate times during the validation procedure. The samples are traceable to standards from the National Institute of Standards and Technology (NIST).

The Validation/Attenuation wheel also holds energy screens. The wheel automatically inserts an energy screen into the beam path to block out a portion of the energy at all frequencies of the infrared beam. The wheel comes with 30%T and 10%T screens and has an open position for collecting spectra without a screen in the beam path. This accessory lets you prevent detector saturation and signal distortion by using a screen to block a portion of the infrared energy. See Using the Validation/Attenuation Wheel for more information.

Optical Filter Wheel – The optical filter wheel selectively reduces the amount of infrared light that reaches the detector by automatically inserting a low- or high-pass filter into the beam path under control of the OMNIC software. See Using the Optical Filter Wheel (Optional) and Installing an Optical Filter in the Filter Wheel (Optional) for more information.

Optical Filter Wheel Filters – The following optical filters are available for use in the filter wheel:

- 1975 cm⁻¹ low-pass optical filter for SSP=8, which are used for step-scan TRS and modulation experiments and polarization modulation experiments
- 3950 cm⁻¹ low-pass optical filter for SSP=4, which are used for step-scan TRS and modulation experiments and polarization modulation experiments
- Polyethylene filter (included with the DTGS detector with polyethylene window)
- Visible filter

Laser Filter – A laser filter is necessary for use with the optional iS50 Raman Module and is only present if you have this accessory. This filter sits inside a fixed mount on the main bench that can be populated with the filter when needed. The laser filter is field-service installable.

Polarizer – The polarizer controls the orientation of the electric field vector of the infrared beam as it enters the sample compartment. This is particularly useful for characterization of monolayers, thin films, and other sample types.

Raman InGaAs Detector – This detector is only present if you have a iS50 Raman Module. The Raman detector is located in the main spectrometer.

Sample Shuttle – A sample shuttle lets you collect background spectra without removing the sample from the sample compartment. The shuttle automatically moves the sample out of the beam path before background collection begins. Since the sample compartment cover is not opened, the system purge is maintained.
Some system accessories must be installed by trained service engineers. Contact us to order any of the following accessories.

**Power Line Conditioner** — Power line conditioners protect your spectrometer and other accessories from damage or malfunction due to voltage dropouts, transient spikes, frequency shifts or other disturbances in your electrical service.

**Pure Air Dryer** — If you have difficulty controlling moisture in your laboratory, the pure air dryer provides additional protection for the hygroscopic elements of your spectrometer. This accessory is also useful if your laboratory air supply is contaminated with volatile solvents, oil or other reactive materials.

**Purge Gas Generator** — If you do not have in-house facilities to supply compressed air or nitrogen for system purge, we offer several purge gas generators.

**Uninterruptible Power Supply** — An uninterruptible power supply reduces the chance of a system shutdown if power is lost.

### Installing Accessories

This section describes how to install accessories.

### Installing a Smart Accessory

- **Note**  The procedure for installing an E.S.P. accessory is slightly different. For instructions, see Installing a Baseplate-mounted Accessory.

- **To install a Smart Accessory**

  1. Remove the sample compartment cover, any connectors at the back of the sample compartment, and the Snap-In baseplate if installed.

  2. Grasp the handle and the front edge of the accessory and lower it straight down into the sample compartment. The accessory fits into guides on the sidewalls of the sample compartment. Use both hands to handle the accessory. Make sure that the accessory is firmly seated.
Begin collecting data.

Since optics are permanently aligned in the Smart Accessories and the Sync module loads your experiment parameters, you're ready to collect data as soon as the accessory is installed. When you're ready to remove the accessory, lift it up and out of the sample compartment.

### Installing a Baseplate-mounted Accessory

These instructions apply to installing both Smart Accessories and Enhanced Synchronization Protocol Accessories.

**CAUTION** Before you install an E.S.P. accessory, be sure to remove the sample compartment cover.

❖ **To install a baseplate-mounted accessory**

1. Remove the Snap-In baseplate if installed.

2. Set the rear edge of the Accessory baseplate down at the back of the sample compartment and lower the front edge.
3. Slide the baseplate back until it snaps in place.

Be sure that the alignment hole fits over the pin near the front of the compartment and the Sync module presses against the three pins at the rear of the sample compartment to establish communication with the computer.

4. Finish installing and connecting the accessory to the spectrometer as explained in the accessory documentation.

There may be electrical or purge connectors, and you may need to position rubber fittings over the windows in the sidewalls of the sample compartment. See the accessory documentation for complete instructions on using the accessory to collect data.

**Note** When you are ready to remove the accessory, insert a finger into the large hole near the front of the baseplate and lift the baseplate out of the compartment just as you would remove any accessory mounted on a Snap-In baseplate.

### Installing Slide-mounted Accessories

The standard sample holder is designed to accommodate slide-mounted accessories (such as a variable angle ATR) as well as thin film samples and optical filters.

* To install a slide-mounted accessory
  1. Slide the accessory into one pair of slots in the standard sample holder.
  2. Tighten the thumbscrew against the accessory support to hold the accessory in place.
Removing the Snap-In Baseplate

Some accessories for the sample compartment do not use the standard Snap-In™ baseplate. Before installing the accessory, remove and replace the Snap-In baseplate with the corresponding baseplate used by your accessory. Additional Snap-In baseplates are available for all accessories. You may wish to have extra baseplates that you keep attached to accessories that you use often, making switching accessories easier and faster.

1. Insert your finger into the large hole near the front of the baseplate.

![Baseplate Removal Illustration]

2. Lift the baseplate out of the compartment.

Cabling an Accessory

When you install an accessory in the sample compartment, you may need to connect one or more cables from the accessory to connectors on the rear wall of the compartment. You may also need to attach cables from other peripherals (such as computers, custom controllers or power supplies) to the accessory or from the accessory to the rear panel of the spectrometer. The instructions that came with the accessory contains specific information on connecting that accessory.

Connectors Inside the Spectrometer Sample Compartment

The following image shows the Accessory Connector and Purge Connector inside the spectrometer sample compartment. They are located at the bottom left corner of the back wall of the compartment.

![Connectors Inside Compartment Image]
Accessories and Application Modules
Installing Accessories

Accessory Connector

**CAUTION** Avoid personal injury. Improper or unsafe cabling can cause damage to your accessory and may create a safety hazard.

- Only qualified persons should connect a cable to the Accessory connector.
- Do not use this connector for signals that exceed ±12 VDC. Limit the current to a maximum of 500 mA.

If you have a photoacoustic or other accessory that has a detector or motor located in the spectrometer sample compartment, connect the cable from the accessory to this standard connector. This is not a pass-through connector. If the accessory has a 15-pin connector, use the sample compartment accessory adaptor cable that came with the system to connect it.

You can use the Accessory connector on the back wall of the spectrometer sample compartment to access power and ground for your own detectors, accessory motors, and other custom hardware.

![Accessory Connector](image)

This table contains pinout information for the Accessory connector:

<table>
<thead>
<tr>
<th>Pin Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>+ 5 VDC</td>
</tr>
<tr>
<td>23</td>
<td>+ 3.3 VDC</td>
</tr>
<tr>
<td>16, 21</td>
<td>+12 VDC (Unfiltered for Motors)</td>
</tr>
<tr>
<td>10, 22</td>
<td>Digital Ground (for +5, +3, and +12 Motor)</td>
</tr>
<tr>
<td>6</td>
<td>+12 VDC (Filtered for Detectors)</td>
</tr>
<tr>
<td>19</td>
<td>-12 VDC (Filtered for Detectors)</td>
</tr>
<tr>
<td>4, 17</td>
<td>Analog Ground (for +12 Det. and -12 Det.)</td>
</tr>
</tbody>
</table>

Purge Connector

Use the purge connector for any accessories located in the spectrometer sample compartment that require purge. Connect the purge tubing from the accessory purge connector to the sample compartment purge connector.

-
Frequently Asked Questions

FAQs About Using OMNIC

This chapter answers some common questions about using OMNIC. Each answer is followed by a reference telling you where to go for more information.

Collecting Spectra

How Do I Setup OMNIC to Collect Spectra?

Choose an existing experiment with pre-set parameters from the Experiment drop-down list box below the OMNIC window menu bar. To setup individual experiment parameters, use Touch Point Setup in the Collect menu.

If you install a Smart Accessory, OMNIC automatically sets up the parameters or a list of appropriate experiments is displayed. Select the desired experiment.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “experiment” > choose “selecting” > view Selecting an Experiment

OMNIC Help Topics > Index tab > find “Touch Point” > view Using Touch Point Setup

How Do I Collect a Spectrum?

Make sure your experiment parameters are setup correctly (described in How Do I Setup OMNIC to Collect Spectra?). (Depending on the Background Handling parameter settings, you may need to insert or remove the sample before collecting a spectrum.) Press the Touch Point that corresponds to the location of the experiment.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectrum” > view Collecting a Sample Spectrum or Collecting a Background Spectrum
How Do I Specify the Y-axis Unit for Collecting Spectra?

Click Collect > Experiment Setup > Collect Tab > select a Final Format

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “units” > view Selecting the Final Format

What Does Gain Do?

Gain amplifies the detector signal intensity, making it larger relative to the level of electronic noise. This is helpful when the IR signal is weak, such as when you use some sampling accessories. You can let OMNIC automatically adjust the gain to maximize the signal by setting the Gain parameter to Autogain. We recommend using this setting to ensure the best spectral quality. To set the gain, go to the Bench tab of Experiment Setup in the Collect menu.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “gain” > view Setting the Gain

When Should I Save Interferograms With My Spectra?

Save interferograms if you think you may want to restore the original data after it has been processed or if you want to keep an archive of your original data. This is strongly recommended for any regulated environments.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “saving, interferograms” > view File Handling

What Does the Collect Sample Window Show?

The Collect Sample window shows the spectrum as it is being collected, a gauge indicating the progress of the collection, an indicator showing whether any problems have occurred, and other information about the collection.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectrum” > view Collecting a Sample Spectrum

How Do I Know Whether My Spectra Are Meeting Quality Standards?

OMNIC continuously monitors the quality of the data you collect based on the parameters you set. The results are displayed in the Collect Status icon in the lower right corner of the OMNIC collect window. The Quality tab in the Experiment Setup dialog box contains parameters for specifying the spectral quality characteristics that you want checked when you collect spectra.
There are four spectral quality checks:

- Spectrum checks
- Parameter checks
- Background checks
- Interferogram checks

When a collected spectrum passes all of the selected quality checks, the Collect Status indicator is a green check mark.

When a collected spectrum does not pass all of the selected quality checks or OMNIC detects a problem, the System Status indicator turns into either a yellow circle or a red X. Click the indicator or View Collect Status in the confirmation dialog box to see the Collect Status results after the data collection is finished.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “quality checks” > view Quality Checks

Converting Spectra to Other Units

How Do I Convert Collected Data to Other Y-axis Units?

Click Process > select Absorbance, % Transmittance or Other Conversions and select a Y-axis unit. See Which Y-axis Unit Should I Use for a Spectrum? for a description of the available units.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “units” > view Selecting the Final Format

Which Y-axis Unit Should I Use for a Spectrum?

Use %Transmittance units if you plan to compare the spectrum visually with published reference spectra.

Use Absorbance units for quantitative analysis measurements and when comparing spectra to commercial libraries you may have purchased.

Kubelka-Munk units are useful for searching diffuse reflectance spectra against libraries of absorbance spectra.

Use Photoacoustic units for spectra collected using a photoacoustic accessory.

Use %Reflectance units for the designation for spectra collected using a reflection technique like ATR. These units are mathematically equivalent to %Transmittance units.
Use Log \((1/R)\) units for spectra collected using a reflection technique for quantitative comparisons. There is often a linear relationship between the concentration of a component and its log \((1/R)\) value. These units are mathematically equivalent to Absorbance units.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find:

“absorbance” > view Converting Spectra to Absorbance Units
“transmittance (\%)” > view Converting Spectra to \% Transmittance Units
“Kubelka-Munk units” > view Kubelka-Munk Units
“photoacoustic units” > view Photoacoustic Units
“reflectance (\%)” > view \% Reflectance Units
“log \((1/R)\) units” > view Log \((1/R)\) Units

Using Spectral Libraries

How Can I Display a Library Spectrum in a Spectral Window?

Locate and select the spectrum in Library Manager (available through the Analyze menu) and then click the Add To Window button, or go to the Library Spectra tab of Library Manager, display the desired spectrum on the tab and then double-click the spectrum.

**Note** Some library spectra are protected against being stored independently due to copyright rules.

Library Manager is not available in OMNIC Lite.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “library” > view Working with Libraries

How Should I Prepare My Spectrum Before Performing a Spectral Search?

There are several corrections you can perform on a spectrum to obtain the best search results:

- If the baseline of the spectrum is sloped, curved or shifted vertically, correct it using Baseline Correct in the Process menu.

- If the spectrum has totally absorbing bands, eliminate them by using Blank in the Process menu. Be careful not to blank regions that contain other important spectral information.

You can also use the region tool to select a region of the spectrum that does not include any totally absorbing bands or use the view finder to display the region before searching. (These methods avoid the loss of spectral information that results from blanking.)
• If you collected the spectrum using specular or diffuse reflection, use **Kramers-Kronig (Dispersion) Correction** (available through **Other Corrections** in the **Process** menu) to correct it for dispersion effects and then search it against a library of absorbance spectra.

• If you collected the spectrum using ATR (Attenuated Total Reflection), use **Advanced ATR Correction** (available through **Other Corrections** in the **Process** menu) to correct the spectrum for variation in the ATR depth of penetration and then search it against a library of Absorbance spectra.

• If the spectrum has water vapor or carbon dioxide peaks, use **Other Corrections** to remove the unwanted peaks.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find:

  “baseline” > view **Correcting a Baseline Manually**

  “blanking spectral region” > view **Blanking a Spectral Region**

  “spectral region” > view **Region Tool** or **View Finder**

  “Kramers-Kronig transformation” > view **Kramers-Kronig Transformation**

  “ATR correction” > view **How to use Advanced ATR Correction**

  “water and carbon dioxide” > view **Water and carbon dioxide correction**

Only those portions of the spectrum that are within the selected region (or displayed region if no region is selected) and within any of the regions you specified for the library using the **Region Setup** tab of the **Library Setup** dialog box will be included in the search. If the spectral range of the spectrum is broader than that of the library spectra, use the region tool to select the region of the spectrum that coincides with the library spectra before you start the search.

You can also use the view finder to display the region to search. The **Search** command operates on the selected region, or on the displayed region if a region is not selected.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectral region” > view **Region Tool** or **View Finder**
How do I Perform a Spectral Search?

First prepare the spectrum (as explained in the answer to the previous question) and display or select the region you want searched. Then set up the search using Library Setup in the Analyze menu and start the search by clicking the Search button in the Library Setup dialog box, or by choosing Search from the Analyze menu.

Analyze > Library Setup > click Search

OR

Analyze > Search

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “library” > view Searching a Spectral Library

How Do I Create a Spectral Library?

To create a library, go to:

Analyze > Library Manager > Library Names tab > Create Library

To add spectra, go to:

Analyze > Add to Library

OR

Library Manager > Library Names tab > drag the spectrum to the Library's Book if the spectral window is not maximized.

You can use a search library you create just as you would a commercial library to identify unknown spectra. You can use a QC library to verify the composition of a sample. If you create a scrapbook library, you can find spectra in it by searching for text (but not by spectral searching).

When you create a library, you determine the kinds of information that will be saved with it.

Library Manager is not available in OMNIC Lite.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “library” > view Creating a User Library and Adding Spectra to a User Library

How Can I Find a Compound in a Commercial Library I Purchased?

To search for a compound name, go to:

Analyze > Library Manager > Library Names tab > select a library > Search for Text tab > enter search terms in Text in Selected Item box > click Search.
For information about a found spectrum, double-click its row in the table.

Library Manager is not available in OMNIC Lite.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “library” > view Searching a Library for Text.

To find library spectra by searching for text in any field included in the library (such as molecular weight, boiling point, or manufacturer), perform an extended search:

Analyze > Library Setup > Extended Search tab > click Use extended search and enter the fields of interest. Then click Search.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “extended search” > view Using Extended Search

**What Is the Easiest Way to Collect Sample Spectra and Add Them to a Spectral Library?**

A quick and easy way to collect a spectrum and add it to a user library in one step:

Analyze > Library Manager > Library Names tab > click Collect Spectrum.

OMNIC automatically sets the experiment parameters so that the spectrum will be compatible with the selected library. This allows you to collect and add a compatible spectrum in one step instead of three (using Experiment Setup to set the parameters, Collect Sample to collect the spectrum and Add To Library to add the spectrum to the library).

Library Manager is not available in OMNIC Lite.

**What Does the Search Expert Do?**

The Search Expert (Library Setup > Search Results tab):

- Determines the search algorithm to use.
- Searches the spectral region from 2600 to 450 wavenumbers.
- Displays the specified number of library spectra that best match the unknown spectrum and any comments about the search results.

For example, the search expert may tell you that the best match is excellent, but the second best match is also similar to the unknown spectrum. You will be able to display the list of matches to see their match values and index numbers.
# Opening, Saving, and Deleting Spectra

## How Do I Open a Stored Spectrum?

File > Open > navigate to the spectrum to open > select the spectrum filename > OK.

To select multiple files, hold down the Control key while selecting filenames.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectrum” > view Opening Spectra

## How Can I Save My Collected Spectra Automatically?

Collect > Experiment Setup > Collect tab > check Save Automatically in the File Handling pane.

Specify a base name for naming the saved spectral data files in the Base name box. A sequential number will be appended to the base name when the spectra are saved. If you want to save the interferograms with the spectra, check Save Interferograms. Individual spectra are saved with the extension .SPA.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “saving, spectra” > view File handling.

## Where Should I Save My Spectra?

You have several locations available for saving spectra: notebook, library, and on your hard drive in specifically named folders. You can use all three methods; you are not limited to just one.

For a permanent record of the spectrum and any other information you want to record, save it in a Report Notebook.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “report notebook” > view Adding a Report to a Notebook

You can also place spectra in descriptively named user libraries that you create. Keeping spectra in libraries allows you to find them by searching for text contained in the information saved with the spectra.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectrum” > view Adding Spectra to a User Library
We recommend that you create descriptively named folders (directories) on your hard disk for different categories of spectra. For example, you could have a folder for each project you are working on, for each of your clients, for each laboratory application, or for each sample type. You can specify which folder to use when saving spectra. This will make it easier to find a spectrum in a particular category when you open a spectrum.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectrum” > view Saving Spectra Using New Filenames

**How Can I Save Several Spectra in One File as a Group?**

To select and spectra, hold down the Control key and click each spectrum you want to select with the selection tool. Choose Group Selected Spectra from the Edit menu. To save the spectra group, select the spectra and then choose Save Group from the File menu. Spectral groups are saved with the extension .SPG.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “group” > view Grouping and Ungrouping Spectra

**How Can I Delete Stored Spectra?**

File > Delete Files > select the spectral data files to delete > choose OK.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectra” > view How to Delete Files

**Can I Delete an Entry From a Report Notebook?**

No. OMNIC’s report notebooks are similar to traditional laboratory notebooks in that information you add to them becomes part of the permanent record of your work.
Printing

How Do I Specify a Printer for Printing Information?

Use Printer Setup in the File menu. See your Windows documentation for details on setting the printer parameters.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “printer” > view Setting up the Printer

How Can I Create and Print Reports of My Work?

Use the commands in the Report menu. First use Template to select, edit or create a template for the report. Then use Preview/Print Report to view the report as it will appear on paper. Click the Print button to print the report.

For more information, see the OMNIC online help menu:

Learning OMNIC > view Creating Reports

OMNIC Help Topics > Index tab > find “template” > view Selecting, Editing or Creating a Report Template

OMNIC Help Topics > Index tab > find “report” > view Previewing or Printing a Report

You also can use Add To Notebook to add the report to a report notebook. You can print the report when you view the notebook using View Notebook.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “report” > view Adding a Report to a Notebook

How Can I Preview Spectra or Other Information Before Printing?

Use Preview/Print Report in the Report menu to view a report as it would appear on paper. The report is displayed using the current report template; that is, the template you specified with Template or the one you are viewing and working with. If the report is displayed correctly, choose the Print button.

You can also click Auto Report to preview an auto report that contains information from the Spectral Results window. Use the features in the Auto Report window to copy or print the report or add it to a report notebook.
For more information, see the OMNIC online help menu:

**OMNIC Help Topics > Index tab > find “template” > view Selecting, Editing or Creating a Report Template**

**OMNIC Help Topics > Index tab > find “report” > view Previewing or Printing a Report**

## Displaying Spectra

### How Can I Select More Than One Spectrum at a Time?

Selecting the first spectrum by clicking it, then hold down the Control key while you click each additional spectrum. You can also choose Select All from the Edit menu to select all the spectra in the window that are not hidden.

For more information, see the OMNIC online help menu:

**OMNIC Help Topics > Index tab > find “spectra” > view Selection tool or Selecting All the Spectra in a Spectral Window**

### How Can I Specify Colors for Displaying Spectra?

Go to Edit > Options > View tab > Spectral Colors.

Click the color next to the spectrum number for which you want to specify the color and then click the desired color in the color array. To specify the color for selected spectra, click the color next to Selected Spectrum and then click a color. Red is typically reserved for displaying selected spectra. To make the display changes permanent, you must save your configuration. Go to File > Save Configuration As.

For more information, see the OMNIC online help menu:

**OMNIC Help Topics > Index tab > find “spectra” > view Specifying Colors for Spectra and Other Features**

You can also specify colors for displaying spectra in a particular spectral window. Select the spectra for which you want to specify a color, choose Display Setup from the View menu, click the desired color in the color array, and choose OK. When the spectra are no longer selected, such as after you select a different spectrum, they will be displayed in the color you clicked.

For more information, see the OMNIC online help menu:

**OMNIC Help Topics > Index tab > find “spectra” > view Selecting a Color for the Currently Selected Spectra**
What Is the Difference Between the Display Setup Parameters and the Window Options?

The parameters in the Display Setup dialog box affect the currently active spectral window only. The options in the Window options (in the Options dialog box, available through the Edit menu) affect all the new spectral windows that you create. After you create a new spectral window, you can change the way spectra are displayed in it by using Display Setup in the View menu.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “display parameters” > view Setting the Display Parameters

OMNIC Help Topics > Index tab > find “Window options” > view Window Options

What Can I Do with the “Scale” Commands in the View Menu?

You can display spectra so that they are easier to see or compare.

Full Scale displays the spectra so that they perfectly fit their panes vertically. Automatic Full Scale does this automatically when you change the display with the view finder or selection tool. The Y-axis displayed corresponds to the selected spectrum.

Common Scale displays all the spectra so that they are not cut off at the top or bottom and use the same Y scale. This allows you to compare the band intensities of different spectra.

Match Scale changes the Y scale of the spectra to be the same as that of the selected spectrum. (The selected spectrum’s scale is not changed.) This allows you to compare the band intensities of different spectra.

Offset Scale shifts the spectra vertically so that they overlap less, making them easier to see.

When you use these commands, remember that the current Y-axis is always accurate for the currently selected spectrum but may not apply to other spectra in the window.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectra” > view:

Displaying Spectra Full Scale or Displaying Spectra Full Scale Automatically
Displaying Spectra Using The Same Y-axis
Matching the Y Scale of a Spectrum
Displaying Spectra Vertically Offset for information about Offset Scale
How Can I Zoom in on an Area of a Spectrum?

Draw a box around the area using the selection tool and then click inside the box.

You can also use the Expand/Contract buttons at the left end of the view finder or drag the regions markers in the view finder to display a smaller spectral region. You can press and hold down the mouse button during these operations to continuously expand or contract the display.

To expand and contract the spectra horizontally about the center, use the view finder’s Horizontal Expand/Contract buttons (left-most). To expand and contract the spectra vertically about the center, use the Vertical Expand/Contract buttons (right-most).

The Roll/Zoom Window in the View menu also expands or contracts an area.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “Roll” > view Rolling and Zooming Spectra

How Can I Move a Spectrum Up or Down in Its Pane to See it Better?

Use the selection tool to drag the spectrum up or down. The Roll/Zoom Window available in the View menu can also be used to move a spectrum up or down.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “Roll” > view Rolling and Zooming Spectra

How Can I Move a Spectrum into Another Spectral Window?

Use the Selection tool to drag the spectrum from one spectral window to another. A copy of the spectrum appears in the second window, and the original spectrum remains in the first window. You can also copy or cut the spectrum using Copy or Cut in the Edit menu and then paste it into another spectral window using Paste.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectrum” > view Selection Tool

OMNIC Help Topics > Index tab > find “pasting, spectrum” > view Pasting Items

How Can I Move a Stacked Spectrum into Another Pane?

Use the Selection tool to drag the spectrum from one pane into another.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectrum” > view Selection Tool
How Can I Find the X and Y Values of a Point in a Spectrum?

Use the Spectral Cursor tool to click the point. The values are displayed in the readout above the palette.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “X and Y values” > view Spectral Cursor Tool

How Can I Find the Height of a Peak?

Use the Peak Height tool to click the top of the peak. (OMNIC finds the top of the peak when you Shift key is held down during the mouse click.) Then drag the baseline handles to adjust the baseline used for the measurement. The corrected (measured above the baseline) and uncorrected height values appear in the readout above the palette.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “peak” > view Peak Height Tool

How Can I Find the Area of a Peak?

Use the peak area tool to drag across the peak. Then drag the baseline handles to adjust the baseline used for the measurement. The corrected (measured above the baseline) and uncorrected area values appear in the readout above the palette.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “area” > view Peak Area Tool

Correcting Spectra

Should I Correct the Baseline of My Spectrum?

If a baseline is sloped or curved or significantly above zero absorbance (or below 100% transmittance), a likely cause is how the sample was prepared. By correcting the baseline, you can often avoid having to prepare the sample again and collect a new spectrum.

Correcting a baseline will give you better results when you search the spectrum against a library, subtract the spectrum from another spectrum, find peaks in the spectrum, or quantify components in the spectrum.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “baseline” > view Correcting a Baseline Manually
Using Spectral Math

How Can I Subtract a Spectrum from Another Spectrum?

Use Subtract in the Process menu to subtract one spectrum from another. Subtract is available only when two spectra are selected. The two spectra must be in absorbance mode for subtraction, as this is the linear representation of the data.

Select the spectrum from which you want to subtract spectral features; this is the sample spectrum. Then hold down the Control key and select the spectrum with the features you want to subtract from the sample spectrum; this is the reference spectrum.

Choose Subtract from the Process menu. The difference spectrum is displayed full scale in the bottom pane. This spectrum is the result of subtracting the reference spectrum from the sample spectrum using the subtraction factor shown to the left of the result. If you are not satisfied with the subtraction result, you can change the subtraction factor.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectrum” > view Subtracting Spectra

What Should I Use Subtraction for?

Subtract is commonly used to remove spectral features of solvent residues or pure components from the spectrum of a mixture of compounds. When you use Subtract, the software calculates data point by data point the difference between the two.

Spectral subtraction is useful in situations such as:

• Eliminating solvent peaks in a spectrum of a sample that is dissolved in a solvent.
• Separating components from a sample that is a mixture of two or more components.
• Identifying an unknown contaminant by subtracting out the known sample material.
• Ensuring quality by subtracting an original batch sample spectrum from a spectrum from the next batch.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectrum” > view Subtracting Spectra

What Other Mathematical Operations Can I Perform on My Spectra?

You can manipulate spectra using any of the common math operations. Use Spectral Math in the Process menu to perform these operations on one or two selected spectra. Specify the operations to perform by typing a sequence of mathematical symbols and numbers in the Operation text box. You can also select one of the example operations provided in the Operation drop-down list box. OMNIC performs the operations on the Y values of the data points in the spectrum or spectra and then displays the result spectrum.
For more information, see the OMNIC online help menu:

Learning OMNIC > view Using Spectral Math

OMNIC Help Topics > Index tab > find “spectrum” > view Performing Arithmetic Operations on Spectra

Customizing OMNIC

How Can I Customize My OMNIC Software?

Use Options in the Edit menu to set options that determine how the software operates. You can also customize the menus and the toolbar using Edit Menu and Edit Toolbar in the Edit menu.

Use Save Configuration As in the File menu to save your customized settings in a configuration file. You can then open the file later to reset OMNIC to your preferences in one step.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find:

“options” > view Customizing OMNIC by Setting Options

“menu” > view Customizing a Menu

“toolbar” view > Customizing a Toolbar

“configuration” > Opening a Configuration and Saving a Configuration

Other Questions

How Can I Find and Label Peaks in Spectra?

Use Find Peaks in the Analyze menu to find and label peaks above a specified threshold.

You can also use the annotation tool to label individual peaks.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “peaks” > view Finding Peaks Above a Specified Height

OMNIC Help Topics > Index tab > find “label” > view Annotation Tool
How Can I Select a Spectral Region for an Operation?

Use the Region tool to drag the cursor across the region of interest in the spectral pane.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “spectral region” > view Region Tool

How Can I Display Information About How a Spectrum Was Collected and Processed?

Select the spectrum and then click Information on the left side of the title box. You can also double-click the spectrum's title in the title box.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “collection and processing” > view Collection and Processing Information

If you want to display this kind of information in a spectrum's pane, choose Display Setup from the View menu, check Sampling Information and then specify the types of information you want displayed by selecting them in the Sampling Information pane.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “displaying” > view Displaying Sampling Information

How Can I See the Results of the Most Recent Search, Find Peaks, QCcheck or Quantify Analysis Performed on a Spectrum?

Click the arrow to the right of the title box to display the list of spectrum titles, click the title of the spectrum, and then click the Results button (labeled “r”) to the left of the title box. The Spectral Results window appears.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “results” > view Spectral Results

How Can I Copy a Spectrum and Paste It into a Text Document?

Select the spectrum and choose Copy from the Edit menu. Paste the spectrum into your document by using the Paste function in the text document program or by using Ctrl-V.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “copying” > view Copying Items
How Can I Get Online Help While Using the Software?

The OMNIC online Help system lets you quickly find answers to your questions about using the software. There are several ways to enter the Help system:

- To see information about a particular control or drop-down menu item in OMNIC, click the item using the right mouse button. A brief description appears and, in most cases, one or more buttons that you can click to display more detailed information. Click the Discussion button to display a complete discussion of the control, menu item (or the dialog box or window that contains the control). Click the How To button to display a step-by-step procedure for using the feature (or the dialog box or window that contains the feature).

- You can press the F1 function key at any time to see a discussion topic for the currently displayed or selected menu item, control, dialog box or window.

- If a dialog box or window contains a Help button, click it to see information about the dialog box or window (or the command that displayed it).

- Choose a Help system or tutorial from the Help or SST menu (only in OMNIC SST).

- Choose Advanced Applications from the SST menu (only in OMNIC SST).

FAQs About Using the Spectrometer

This chapter answers some common questions about using your spectrometer. Each answer is followed by a reference telling you where to go for more information.

What Do the Touch Points Do?

Each Touch Point performs three functions:

1. Communicates status

   The Touch Points communicate the spectrometer status by displaying different states of illumination:

   - Off: The corresponding sample point is inactive.
   - On: The corresponding sample point is active.
   - Blinking: The spectrometer is being configured to use the corresponding sample point.
2. **Configures internal components**

Pushing a Touch Point prompts the spectrometer to position the internal components into the correct configuration for an experiment. Specifically, the spectrometer moves the internal optics to create the beam path required by the experiment to be conducted with the corresponding sample point. This Touch Point blinks during configuration. When configuration is complete, the Touch Point stops blinking and stays on. Experiment configuration parameters are set up in OMNIC.

3. **Starts sample collection**

When the spectrometer is configured for an experiment, pushing a Touch Point starts the experiment using the corresponding sample point.

See **Touch Points** for more information.

---

**What do the LEDs Indicate?**

There are two LEDs on the spectrometer next to the power switch. One indicates system status and the other communicates system-scan activity.

**System Status**

The system status LED has two modes: **steady blue** to indicate the system is ready, and **blinking yellow** to indicate that an error has occurred. When the spectrometer is turned on, this LED will blink blue.

**System Scan**

The system-scan LED blinks blue with each scan of the interferometer.

---

**Do I Need to Use an Energy Screen with My Detector?**

If you are using a highly sensitive detector such as a PbSe, Si, MCT-A, or InSb detector and your experiment deals with information from a broad range of frequencies, use an energy screen to prevent the detector from becoming saturated or producing a distorted signal. There are two energy screens available on the Validation/Attenuation wheel, which can be accessed on the **Bench Setup** menu or through a Macros Basic DDE command. See **Using the Validation/Attenuation Wheel** for more information.

In the OMNIC online help menu:

OMNIC Help Topics > Search tab > find “energy screens” > view Controlling the Attenuation Wheel
**When Do I Need to Open the Spectrometer Covers?**

You need to open the spectrometer covers to change user-replaceable components such as a source or to install a spectrometer component such as a laser. When the covers are off, the sensitive hygroscopic optics are exposed to atmospheric water. Minimize this exposure by only opening the covers as required. Do not operate the spectrometer with the covers open. The covers protect you from exposure to laser light and live electrical connections.

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.

- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

**CAUTION** Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.

**When Should I Align the Spectrometer?**

Align the spectrometer after you install a new beamsplitter, replace the laser, or move the spectrometer. It is also advised to align the spectrometer if the signal intensity has dropped significantly from its usual level. For best performance, align the spectrometer at least once a week, or once a day if you are performing step-scan or other advanced experiments.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “aligning, spectrometer” > view Aligning the Spectrometer

**Does My Detector Need to Be Cooled With a Cryogen?**

Detectors that have a dewar need to be cooled. Dewar detectors are fairly large metal cylinders with a hole in the top. These include MCT and InSb detectors. To determine if your detector requires cooling, open the detector compartment cover and see if the detector has a dewar.

If during a work session you find that the signal intensity from your cooled detector is decreasing, it may need to be refilled with liquid nitrogen. With proper care and filling, a detector dewar should maintain its insulating vacuum for several years.
If the vacuum leaks, the insulation will lose effectiveness and the following symptoms may occur:

- Liquid nitrogen evaporates much faster than usual.
- The outside of the dewar stays cold more than 30 minutes after filling and may feel damp or become frosted.
- Water and atmospheric contaminants condensing on the detector window appear in spectra as unwanted peaks.

**NOTICE**  If the detector dewar loses vacuum, restore the vacuum as soon as possible. Leaving the detector elements exposed to atmospheric pressure can damage them.

If you suspect that the detector dewar has a vacuum leak, contact us.

See Cooling a Detector for more information.

**When Should I Change the Desiccant?**

The desiccant should be monitored regularly and changed when necessary. Check the round indicator on the desiccant access cap once a month. If the indicator is blue, the desiccant does not need to be changed. If the indicator is pink or white, change the desiccant.

See Checking the Desiccant and Replacing the Desiccant for more information.

**Which Source Should I Use?**

Use the source that is appropriate for the spectral range of your experiment (determined by the ranges of the beamsplitter and detector). We offer a Mid-IR to Far-IR source (Polaris) and a Near-IR source (white light).

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “source” > view Specifying the Source Type

See Using a Light Source for more information.

**Should I Turn off the Spectrometer When I’m Not Using It?**

We recommend that you leave the spectrometer on at all times. This improves the thermal stability of the system and provides more consistent results when you collect spectra.
How Can I Diagnose Problems with the Spectrometer?

The performance of the spectrometer is monitored while you collect spectra. If a problem occurs, a troubleshooting message appears.

See Troubleshooting for instructions on diagnosing spectrometer problems.

You can also perform a more thorough check on a spectrometer component:

1. Choose Collect > Experiment Setup.
   
The Experiment Setup dialog box appears.

2. Click the Diagnostic tab.
   
A series of icons appears at the top of the Diagnostic tab. The icons represent the major components of the spectrometer: the power supply, laser, source, electronics, and beamsplitter and detector. Click on an icon for information on the status of a component, troubleshooting information, replacement procedures, and information on ordering replacement parts.

For more information, see the OMNIC online help menu:

OMNIC Help Topics > Index tab > find “diagnostics” > view Checking the Spectrometer Components

See Diagnostics for more information about these tests and other advanced diagnostics tests.

How Do I Replace Parts in the Spectrometer?

This table lists the user-replaceable parts and their replacement instructions. For Sampling Modules and parts, refer to the specific module documentation for instructions. For all other parts, contact us.

<table>
<thead>
<tr>
<th>User-replaceable part</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Replacing the Light Source</td>
</tr>
<tr>
<td>Detector</td>
<td>Changing a Detector (the fixed detector is not user-replaceable)</td>
</tr>
<tr>
<td>Laser</td>
<td>Replacing the Laser</td>
</tr>
<tr>
<td>Beamsplitter</td>
<td>Manually Installing a Beamsplitter</td>
</tr>
<tr>
<td></td>
<td>Manually Removing a Beamsplitter</td>
</tr>
<tr>
<td></td>
<td>Installing a Beamsplitter into the ABX</td>
</tr>
<tr>
<td></td>
<td>Removing a Beamsplitter from the ABX</td>
</tr>
<tr>
<td>Power supply</td>
<td>Replacing the Power Supply</td>
</tr>
<tr>
<td>Sample compartment window</td>
<td>Replacing the Sample Compartment Windows</td>
</tr>
<tr>
<td>User-replaceable part</td>
<td>Instructions</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------</td>
</tr>
<tr>
<td>Optical filter</td>
<td>Installing an Optical Filter in the Sample Compartment</td>
</tr>
<tr>
<td></td>
<td>Installing an Optical Filter in the Filter Wheel (Optional)</td>
</tr>
<tr>
<td>Optical beam port window</td>
<td>Installing an Optical Beam Port Window</td>
</tr>
<tr>
<td></td>
<td>Removing an Optical Beam Port Window</td>
</tr>
<tr>
<td>External beam port cover</td>
<td>Installing an External Beam Port Cover</td>
</tr>
<tr>
<td></td>
<td>Removing an External Beam Port Cover</td>
</tr>
<tr>
<td>Desiccant, humidity indicator</td>
<td>Replacing the Desiccant</td>
</tr>
<tr>
<td>Purge gas filter</td>
<td>Checking and Changing the Purge Gas Filter</td>
</tr>
</tbody>
</table>
Maintenance

This section describes the maintenance routines to perform on the spectrometer to keep it running efficiently.

**CAUTION** Avoid personal injury. Perform *only* those procedures described in the documentation. If there are other problems, contact us. Any other service must be performed by trained personnel.

Static Electricity Precautions

**NOTICE** Critical components in your instrument can be permanently damaged by static electricity. To help prevent such damage, follow these recommendations:

- Before you remove a system cover or handle detectors, *always* discharge any static electricity you may have accumulated by touching the metal base of your instrument.

- **Do not** touch any printed circuit board in your instrument (such as the circuit board on the detector).

- **Do not** remove replacement components from their protective packaging until you are ready to install that component in your instrument.

Cleaning the Spectrometer

**CAUTION** Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.

If the outside of the spectrometer needs cleaning, turn it off and disconnect the power supply. Then use a damp (not wet), soft cloth and a mild soap to clean the outside of the spectrometer.
Cleaning the ABX Cover

Clean the ABX cover just as you would clean the outside of the spectrometer. Be sure to turn the spectrometer off and remove the power supply before cleaning.

Maintaining Detector Dewars

If your instrument has a liquid-nitrogen cooled detector, it will include a detector dewar. With proper care, a detector dewar should maintain its insulating vacuum for several years. If the vacuum leaks, the insulation will lose effectiveness and the following conditions may occur:

- Liquid nitrogen boils off much faster than usual.
- The outside of the dewar stays cold more than 30 minutes after filling and may feel damp or become frosted.
- Water and atmospheric contaminants condensing on the detector window show up in spectra as unwanted peaks.

**NOTICE**  If any of these conditions occur, contact us immediately for assistance. Leaving internal detector elements exposed to atmospheric pressure can cause permanent damage.

We strongly recommend that you return the detector to the factory to be repaired. For a short-term, temporary solution only, you can restore the vacuum in a detector dewar if you have the proper equipment. The vacuum must be pumped to approximately .000001 torr. A special evacuation valve for pumping out dewars is available; to order, contact us.
Checking Internal Humidity

The spectrometer is tightly sealed and its optical components must be protected by desiccant or purge gas.

**NOTICE** We recommend that you maintain seal and desiccation and/or purge your instrument at all times. Equipment damage due to failure to maintain seal and desiccation and/or purge is not covered under the warranty. If you have questions about this requirement, contact us.

Keep all covers closed tightly while the spectrometer power is off and check the humidity indicator at least once a month.

To check the humidity indicator on the spectrometer, look at the indicator label on the desiccant compartment cap. If it is blue, the humidity level is OK. If it is pink or white, replace the desiccant.

Replacing the Desiccant

If the purge is off, use the humidity indicator to monitor the humidity level inside the spectrometer. Replace the desiccant when the indicator turns pink or white. Replace the humidity indicator each time you replace the desiccant. Desiccant can also be regenerated.

**NOTICE** Keep all covers closed tightly while the spectrometer power is off and check the humidity indicator at least once a month. Replace the expired desiccant with a new desiccant once per year or more, depending on your lab environment.

Time needed: Five minutes or less

Tools needed: None

Video: Changing the desiccant
**Regenerating the Desiccant**

If the desiccant is saturated, an alternative to replacing it is regenerating it by drying it in an oven. However, regenerating the desiccant will not restore it to its full, original capacity. Expect a shorter drying capacity time when using regenerated desiccant. We recommend using regenerated desiccant only once.

The humidity indicator must be replaced when using regenerated desiccant.

**Time needed:** 24 hours

**Tools needed:** Vented oven, insulated cloth or hot pad

---

**CAUTION**  Avoid burn hazard. Use an insulated cloth or hot pad to handle the heated desiccant bags. Let the desiccant bags cool to room temperature before reinstalling them into the spectrometer.

**NOTICE**  If you are going to dry and reuse saturated desiccant, make sure you have fresh desiccant you can place in your instrument while the saturated desiccant dries.

Do not leave desiccant in the oven for more than 24 hours. Do not exceed a temperature of 135°C (275°F).

Make sure the insulated cloth or hot pad you use to handle the regenerated desiccant is not contaminated with substances that could be absorbed by the desiccant and subsequently released into your instrument.

---

**To regenerate saturated desiccant**

1. Place the saturated desiccant bags in a vented oven at 135°C (275°F) for 24 hours.

2. Remove the desiccant from the oven using an insulated cloth or hot pad.
   
   Allow the bags to cool on the hot pad or cloth. Do not attempt to handle or install them until they have cooled to room temperature.

3. When the desiccant bags reach room temperature, immediately install them into your instrument or seal them in an airtight container or bag. Otherwise, they will absorb moisture from the air in the room and quickly become saturated again.

4. Replace the humidity indicator in the desiccant access cap after installing the desiccant into the spectrometer.
Checking and Changing the Purge Gas Filter

**NOTICE**  We recommend that you maintain seal and desiccation and/or purge your spectrometer at all times. Equipment damage due to failure to maintain seal and desiccation and/or purge is not covered under the warranty. If you have questions about this requirement, contact us.

If your spectrometer has the purge option (see Installing Purge Controls), check the purge filter occasionally to make sure it is clean and dry.

If the filter is clean and white, it does not need replacement. If the filter is discolored or contaminated with debris, replace the filter.

**Time needed:** Five minutes or less

**Tools needed:** None

❖ **To change the purge gas filter**

1. Turn off the purge gas at the main valve.
   
   Do not turn down the flowmeter or the pressure regulator.

2. Remove the plastic cover over the filter and then remove the filter.
   
   You can unscrew them both by hand.

3. Install the new filter and then reinstall the cover.

4. Turn on the purge flow to the spectrometer; see Setting Purge Gas Controls.

**Note** You may notice increased levels of water in spectra collected immediately after you have had the purge gas turned off. If this interferes with your data, wait 15 to 60 minutes until purge is completely re-established.
Aligning the Spectrometer

Your instrument can be aligned automatically using OMNIC software. Alignment optimizes the energy throughput to the detector. Align the spectrometer once a month or each time you perform any of the following actions:

- Before collecting a critical set of experiments
- Collect quantitative standards
- Move the spectrometer
- Install a new beamsplitter
- Replace the laser

Align the instrument if the signal intensity has dropped significantly from its usual level.

**Note**  The spectrometer power should be on for at least 15 minutes (1 hour or longer for best results) before you perform an alignment. Aligning the system before it has warmed up and stabilized may give inconsistent results. For best results, leave the instrument power turned on all the time to maintain thermal stability and to avoid long term degradation of the instrument optics when turned off.

The instrument is aligned automatically each time you run a System Performance Verification (SPV) test. We recommend that you run an SPV test at least once a month.

**To align the spectrometer**

1. Remove any samples or accessories from the sample compartment.
2. Choose Collect > Experiment Setup.
3. Click the Bench tab and set Sample Compartment to Main.
4. On the Bench tab, set Gain to 1.
5. Click the Diagnostic tab.
6. Click Align.

For more information, open the OMNIC online help in the Help menu and search for “Aligning the Spectrometer.”
Aligning an Accessory

Some accessories that mount inside the spectrometer sample compartment occasionally require alignment. To determine whether an accessory requires alignment, see the documentation that came with the accessory. For Smart Accessories, refer to the OMNIC online help tutorial for the specific Smart Accessory in question.

If an accessory requires alignment, first align the spectrometer without the accessory installed. Then set Sample Compartment on the Bench tab of the Experiment Setup dialog box according to the accessory location. On the Bench tab, set Gain to a fixed value that gives a signal intensity that is appropriate for the accessory. ATR and diffuse reflection accessories typically use a gain setting of 2 or 4.

If you are not satisfied with the signal intensity after alignment, you can manually align some accessories to maximize the signal. For complete instructions, see the manual that came with the accessory.

When you manually adjust an accessory, watch the largest interferogram peak in the live display on the Bench tab. The larger this peak, the better the signal intensity is.

**Note** The largest interferogram peak can be positive or negative.

If you are unable to see the display, select Tone below the live display before adjusting the accessory. The tone reaches its highest pitch when the signal is maximized.
Diagnostics

This section explains how to use the diagnostic software features to find and correct problems that occur when you use the spectrometer.

Checking Spectrometer Components

OMNIC software continuously monitors the operation of the spectrometer hardware. The system status indicator to the right of the title bar shows the spectrometer status. If your spectrometer is not performing properly, go to the Diagnostic tab in the Experiment Setup dialog box to check the performance of spectrometer components and determine the source of the problem.

❖ To check spectrometer components and run performance tests:

1. Remove any sample or accessory from the spectrometer sample compartment.

2. Choose Collect > Experiment Setup.

   The Experiment Setup dialog box appears.

3. Click the Diagnostic tab.

   A series of icons appears at the top of the Diagnostic tab. The icons represent the major components of the spectrometer.

4. To check the status of a component, click the icon for that component.

   A dialog box shows information about the component. If the operating values for the component are within the acceptable range, a check mark appears in the Status column. If a value is outside the acceptable range, an X appears in the Status column.

   When you are finished viewing the information, click OK.
OMNIC provides advanced diagnostic tests for the main components of the spectrometer. If you have problems with your spectrometer, run these tests to determine the source of the problem.

The diagnostics provide information on the status of the component as well as troubleshooting information. If you need to order parts, contact us.

Use the Advanced Diagnostics software to:
• Run the spectrometer signal-to-noise test.
• Test specific components of your spectrometer.
• Get additional troubleshooting tips.

The Advanced Diagnostics program includes performance tests for step-scan and dual-channel experiments, rapid scan, and the expanded spectral range experiments available with your spectrometer.

**Note** Before starting the Bench Diagnostics, verify that the appropriate beamsplitter and detector(s) are installed in your spectrometer.

**To run the Advanced Diagnostics test**

1. Remove any samples or accessories from the sample compartment.
2. From the **Collect** menu, select **Advanced Diagnostics**.
3. Select **Performance Test**.
4. Select the beamsplitter from the **iS50 Tests** drop-down box.
5. Check the box next to the detector(s) to test in the **Test Item** column.
6. Select **Run Selected Test**.

   The test results will be displayed for each test in the **Actual** and **Status** columns.

**Note** If the spectral baseline noise readings are greater than normal or have changed significantly, contact us.

7. Click this button to return to the main Diagnostics window.

8. Select **Report** to save the results.

Exit the diagnostics software by clicking **Close** at the far right end of the title bar.
Dual-Channel Diagnostic Test

**Note** Dual channel is available only with the iS50R or an iS50 with the dual-channel option.

Choose PEM to test the dual-channel circuitry. You do not need to set any data collection parameters before running this test. However, you may need to reset the parameters before running your next dual-channel experiment.

You must install cables before using this test.

**To run the dual-channel diagnostic**

1. Install a BNC “T” connector on the Channel A input on the hub.
2. Use BNC-to BNC cables and connect the Channel B input and the Interferogram to the Channel A input.
### Step-scan Diagnostic Test

**Note**  Step-scan is available only with the iS50R.

The step-scan data collection circuitry can be tested for a variety of modes.

#### Amplitude Modulation

Choose **AM Step-Scan** to test the step scan amplitude modulation circuitry. You do not need to set any AM setup parameters before running this test. Your parameters will be restored when the test is completed. You must install a cable and an energy screen before using this test.

- **To run the amplitude modulation diagnostic**
  1. Connect a BNC-to-BNC cable between the Channel A input and Interferogram output connectors on the hub.
  2. Select a B screen from the energy screen wheel in the Experiment Setup dialog box.

#### Phase Modulation

Choose **PM Step-Scan** to test the step-scan phase modulation circuitry in the spectrometer and report the signal to noise ratio.

No cable connections are required. You do not need to set any phase modulation data collection parameters before running this test. Your parameters will be restored when the test is completed.
Multiple Modulation

Choosing SMM runs a simulation of a multiple modulation experiment. It verifies the basic operation of the spectrometer electronics. This test requires cable connections.

Use two BNC-to-BNC cables to connect the Laser R Analog output to the Synch In input and the Interferogram output to the Channel B input on the hub.

Time-resolved

This test checks the step scan time resolved circuitry in the spectrometer and is available only if your system is equipped with the optional OMNIC SST with Time-Resolved Experiments software.

**NOTICE**

- If you are not planning to run a TRS experiment, disconnect the data acquisition card cables from the spectrometer when you finish running the TRS tests. Never leave the spectrometer connected to the data acquisition card when you are not running TRS experiments or tests. It could affect your data.

- Turn off and disconnect the main power supply when installing a time-resolved detector.

You do not need to set any TRS setup parameters before running this test. Your parameters will be restored when the test is completed. The results will be reported as the signal-to-noise ratio and will indicate whether the spectrometer passed or failed.
You must install cables before selecting this test. You may also need a data acquisition card installed in your computer. During the test, choose Yes when prompted for information about the background source.

**To run the time-resolved diagnostic**

1. Install a BNC “T” connector on the Channel A input connector on the hub.

2. Install three BNC-to-BNC cables.

   Use one cable to connect the Channel A input and the Interferogram output on the hub.

   Use a “T” connector and a second cable to connect the Channel A input to the channel 1 input on the data acquisition card (or the Channel B input connector on the hub, for internal TRS data collection).

   Use a third cable to connect the Trigger output on the hub to the trigger input (EXT) on the data acquisition card.
Service

This section provides instructions for installing or removing optional hardware and replacing spectrometer components. For information about running performance and diagnostic tests, see Diagnostics.

CAUTION  Avoid personal injury. Perform only those procedures described in the documentation. If there are other problems, contact us. Any other service must be performed by trained personnel.

Installing or Removing Optional Hardware

Installing a Purge Kit

The instrument is sealed and desiccated; however, it does contain precise optical components that may be damaged by a moist environment. To protect those components, we strongly recommend installing a source of clean, dry air or nitrogen to purge the spectrometer. It is especially important if humidity levels are above 70% RH in the laboratory environment.

NOTICE  Optical damage caused by failure to maintain the desiccants or to purge the spectrometer is not covered under your warranty.

You may also have a laboratory environment that contains solvents or other agents that can corrode spectrometer components. Purging the spectrometer will better protect the components.

NOTICE  The interaction of chlorinated solvents, perfluorochlorinated solvents, or other solvents containing halogenated hydrocarbons (for example, Freon®) with an IR source can corrode spectrometer components. Do not leave these solvents exposed around the spectrometer any longer than necessary.

Purging the spectrometer can also ensure more accurate results. This is particularly true when measuring sample components that are also present in your laboratory environment.
Selecting a Purge Gas

**WARNING** Avoid explosion hazard. Never use a flammable, combustible, or toxic gas to purge this instrument. The purge gas must be free of oil and other reactive materials. Heat from the source or from laser absorption may ignite flammable gases or reactive materials in purge gas. Use only dried air or nitrogen to purge your instrument.

Dry air and nitrogen are equally effective in eliminating water vapor and volatile solvents, but nitrogen will remove carbon dioxide from your spectrum more effectively. The purge gas must be free of moisture, oil, and other reactive materials. To remove particulate matter and oil, you may need to install a 10-micrometer filter. Dry air or nitrogen supplied for purge should be dried to a dew point of -70° C (-94° F) or below for best performance.

**NOTICE** Do not use argon as a purge gas. Argon is an insulator and prevents the system from cooling properly.

Purge Gas Generators

If your facility does not have a source of clean, dry compressed air or nitrogen for system purge, we recommend using a purge gas generator. It cleans and dries the air supplied by an air compressor so it can be used to purge the instrument. If your facility does not have an air compressor, a complete dry-air generating system is available. Contact our sales or service representative in your area for more information.

**NOTICE** If using a purge gas generator:

- Position it as far from the instrument as practical to reduce noise and vibration.
- Purge gas generators require a minimum pressure for proper operation. Failure to supply this pressure may allow moisture to enter the system, causing permanent damage.
- Read the manufacturer’s instructions before installing air-drying equipment or performing any maintenance. The installation and maintenance of air-drying equipment is your responsibility. Failure to perform routine maintenance as specified by the manufacturer may void your instrument warranty.
- Before connecting a new air dryer to the instrument, it is vital to purge the dryer of water and particulates by running it for at least 12 hours at nominal air flow. Otherwise, there is risk of severe damage to the instrument when you connect the pure air dryer.
Installing Purge Controls

If you plan to purge the instrument, you must install the purge line and on/off valve before the instrument arrives. The source line pressure delivered to the pressure regulator must be at least 1.4 bar (138 kPa, or 20 psig) and must not exceed 7 bar (700 kPa, or 100 psig), with a minimum flow rate of 20 SCFH.

**WARNING** Avoid explosion hazard. Never use a flammable, combustible, or toxic gas to purge this instrument. The purge gas must be free of oil and other reactive materials. Heat from the source or from laser absorption may ignite flammable gases or reactive materials in purge gas. Use only dried air or nitrogen to purge your instrument.

**Note** Install the purge controls for the spectrometer before installing any other external module purge kits.

See the purge kit installation documentation that came with the module for specific instructions on how to set up the purge controls for that module.

**Time needed:** 30 minutes or less

**Tools needed:**
- A source of dry air or nitrogen
- A 3/4 inch open-ended wrench
- An 11/16 inch open-ended wrench
- A shutoff valve (with a 1/4 inch male or 3/8 inch female fitting)
- Pipe tape

❖ **To install purge gas controls**

1. Install a shutoff valve and either a 1/4 inch male fitting or a 3/8 inch female fitting onto the purge gas source.

Choose a shutoff valve and fittings that are appropriate for the purge gas source.

**NOTICE** Ensure that the purge gas source provides the proper purge gas. See Selecting a Purge Gas.

2. If you used a 1/4 inch male fitting, proceed to the next step.
If you used a 3/8 inch female fitting on the purge gas source, install the 3/8 inch to 1/4 inch reducing nipple that was included with the purge kit. Wrap the reducing nipple with Teflon® pipe tape before you install it, and use an 11/16 inch open-ended wrench to tighten the connection.

**Note** When wrapping the connection with pipe tape, make sure the tape does not cover any of the opening as this may interfere with flow or create noise.

3. Wrap the reducing nipple or the 1/4 inch male fitting with pipe tape, and then install the pressure coupling.

Use a 3/4 inch open-ended wrench to tighten the connection.
4. Install the purge filter, pressure regulator and flowmeter, and then snap the assembly into the pressure coupling.

5. Set the purge gas controls before connecting them to the spectrometer. See Setting Purge Gas Controls for instructions.

**NOTICE** Connecting the purge gas controls to the spectrometer before they are set can cause damage to the spectrometer.

6. Connect the purge controls to the spectrometer, and then snap the flow coupler into the Purge In port on the back of the spectrometer.
Setting Purge Gas Controls

1. Reduce the pressure on the regulator by turning the knob counterclockwise until the gauge indicates that the pressure is 5 psig or below.

2. Turn on the shutoff valve.

3. Increase the pressure regulator by turning the knob clockwise until the gauge indicates that the pressure is 20 psig.
4. Set the flowmeter to 20 SCFH.

Removing and Installing an External Beam Port Cover

External beam ports are used to connect an external accessory to the spectrometer, such as an External Applications Module or a Research Module, for conducting emission experiments or experiments that include an external detector.

Remove the external beam port cover from the spectrometer before connecting an external accessory to the spectrometer. When a beam port is not in use, replace its cover to maintain equilibrium inside the spectrometer.

Removing an External Beam Port Cover

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.

- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.
CAUTION Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.

Time needed: Five minutes or less

Tools needed: None

✧ To Remove an External Beam Port Cover

1. Turn the spectrometer off and remove the power source.

2. Remove the back cover from the spectrometer. See Removing the Back Cover (Non-ABX) or Removing the ABX Cover, depending on your configuration, for instructions.

3. From the inside of the spectrometer, push the beam port cover out through the black rubber gasket and pull it out of the port from the outside of the spectrometer.

4. Store the port cover in a safe place. Keep the cover in the port when the port is not in use.

✧ To remove the port gasket

If you need to remove the gasket, follow these instructions.
Time needed: Five minutes or less

Tools needed: Two screwdrivers - at least one flathead

1. Grasp the edge of the gasket and pull it out of the port.

Tip Removing the gasket may be difficult because of its tight fit in the port. You can pry the gasket edge out of the port using tools such as two screwdrivers, shown here. This will help extract the edge of the gasket so that you can grasp it easily.

To install the port gasket

1. Insert the rubber gasket at an angle into the beam port. Push along the gasket edges while pushing the gasket into the port.
Installing an External Beam Port Cover

When an external beam port is not in use, install a port cover to maintain equilibrium inside the spectrometer.

**To install an external beam port cover**

1. Install a port gasket into the beam port opening if necessary.

2. Insert the cover into the port opening and push the cover straight in until it is all the way into the port.

Installing and Removing an Optical Beam Port Window

To conduct experiments using an external source or an external detector, and if the spectrometer is sealed and desiccated, optical beam port windows must be installed in the external beam ports first. Optical beam port windows look just like beam port covers, except that there is a window in place of the flat surface of the port cover. They are inserted and removed from external beam ports much like the external beam port covers.

When optical beam port windows are not in use, replace the beam port covers to maintain the spectrometer seal.

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.

- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

**CAUTION** Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.
Installing an Optical Beam Port Window

**Time needed:** Five minutes or less

**Tools needed:** Latex-free, non-powdered gloves or finger cots

❖ **To install a beam port window**

1. If there is a beam port cover in the beam port, remove it. Leave the port gasket in.
2. Put on gloves or finger cots.

**NOTICE** Beam port windows are fragile. Do not apply force to optical surface. Damage or breakage during installation is not covered by warranty. Handle beam port windows by the edges only.

3. Hold the beam port window by the edges as shown.

4. Insert the optical beam port window into the port gasket, pushing the window assembly in **only by its edges** until it is all the way into the port.
Removing an Optical Beam Port Window

Time needed: Five minutes or less

Tools needed: Latex-free, non-powdered gloves or finger cots

❖ To remove a beam port window

1. Put on gloves or finger cots.

| NOTICE | Beam port windows are fragile. Do not apply force to optical surface. Damage or breakage during removal is not covered by warranty. Handle beam port windows by the edges only. |

2. From the inside of the spectrometer, push the window assembly out of the port only by the edges, far enough so you can grasp it from outside of the spectrometer.

3. Carefully remove the window assembly from the port gasket.

4. Store it in its protective packaging.

5. If you are finished using this port, install a beam port cover to maintain equilibrium inside the spectrometer.
Installing an Optical Filter

A bandwidth-limiting filter may be used to improve the signal-to-noise ratio of the data and also prevent detector saturation by allowing only energy in your particular area of interest to pass to the detector element. Filters can be installed over a sample compartment window or in the optional filter wheel. See Using the Optical Filter Wheel (Optional) and Using Optical Filters for more information about using filters.

Installing an Optical Filter in the Sample Compartment

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.
- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

The filter sits in a holder that installs over the opening of the spectrometer sample compartment window.

**Time needed:** Five minutes or less

**Tools needed:** Latex-free, non-powdered gloves or finger cots

To install an optical filter in the sample compartment

1. Open the sample compartment cover.
2. Insert the filter holder gasket into the sample compartment window clip.
3. Insert the filter holder.

4. Put on gloves or finger cots and remove the optical filter from its protective packaging.

**NOTICE** Filters can be scratched and ruined very easily. Do not touch or attempt to clean them. Dust will not affect the signal, but fingerprints will degrade the performance of the instrument and permanently damage filters. If you wish to remove dust from a filter, blow it off with a gentle stream of pure nitrogen. Do not use compressed air (from a can or an air compressor). Contaminants will damage the filters.

5. Insert the filter into the filter holder.

---

**To remove a filter from the sample compartment**

1. Put on gloves or finger cots.
2. Grasp the filter by the edges and carefully remove it from the filter holder.
3. Place the filter into its protective packaging.
Installing an Optical Filter in the Filter Wheel (Optional)

**WARNING** Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.
- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

The wheel has six positions: five for optical filters that are 1 inch in diameter and from 1 mm to 4 mm thick, and an open position.

**Time needed:** Five minutes or less

**Tools needed:** Filter installation tool, Latex-free, non-powdered gloves or finger cots

**CAUTION** Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.

✧ To install an optical filter in the filter wheel

1. Turn off the spectrometer power, disconnect the power source, and remove the back cover. If you have an ABX, see Removing the ABX Cover.
2. Put on gloves or finger cots and remove the optical filter from its protective packaging.
3. Choose an empty position to install the filter in. Note the position number; you will need it to configure the filter in OMNIC after the filter is installed. Insert the filter ring wrench into the circular opening. Unscrew the black filter holder ring by turning counterclockwise until free from the wheel.

4. Carefully place the filter into the filter wheel so that the filter sits in the groove. The filter sits in a groove behind the threads inside the circular opening, as shown.

5. Place the filter holder ring against the opening in the wheel as shown, with the notches of the filter ring facing out.

**NOTICE** Filters can be scratched and ruined very easily. Do not touch or attempt to clean them. Dust will not affect the signal, but fingerprints will degrade the performance of the instrument and permanently damage filters. If you wish to remove dust from a filter, blow it off with a gentle stream of pure nitrogen. Do not use compressed air (from a can or an air compressor). Contaminants will damage the filters.
6. Using the filter ring wrench, screw the ring into the opening to hold the filter in place.
   The wrench has two tabs on one end that fit into two corresponding notches in the ring.
   Press the wrench against the ring and turn clockwise to screw it in.
   When the ring stops turning, do not force it to turn any further; the filter can be damaged
   or cracked if the filter ring is screwed in too tightly.

7. Replace the back cover (if you have an ABX, see Replacing the ABX Cover), replace the
   power source, and turn the spectrometer on.

8. Launch the OMNIC software.

9. Choose Collect > Experiment Setup.

10. Select the Configure tab.

11. In the Filter Wheel table, enter a description of the filter in the respective position (1-5).
    This description identifies the filter for experiments that use the filter wheel. The
    description is also added to the collection and processing information for any spectra
    collected with that filter in the beam path.

    **Note** For more information about configuring the filter wheels, in the OMNIC
    online help, find "filter wheel" in the Index, and go to "Entering descriptions of the
    filters in the filter wheel" and "Controlling the filter wheel."
Replacing Components

Several spectrometer components are user-replaceable if they fail. If the spectrometer is sealed and desiccated, you can also replace the sample compartment windows.

**Note** The OMNIC software will alert you to failed or failing components. For information about diagnosing spectrometer problems, see Diagnostics.

The fuses that protect the spectrometer are located inside the power supply. The individual fuses cannot be replaced. If a fuse blows, you must replace the power supply; see Replacing the Power Supply. Contact us to order a new power supply.

Replacing the Light Source

**CAUTION** Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.

**CAUTION** Avoid burn hazard. The source becomes extremely hot during normal spectrometer operation. Turn off the spectrometer power and wait at least 10 minutes before removing a source from the spectrometer.

Time needed: 30 minutes or less

Tools needed: None

❖ To remove a source

1. Turn the spectrometer off.
2. Disconnect the power supply.
3. Wait 10 minutes for the source to cool.
4. Remove the sample compartment cover.
5. Remove the back cover. For an ABX, see Replacing the ABX Cover.
6. Remove the IR or NIR source.

Video: Removing the IR source
Video: Removing the NIR source
To replace a source

1. Replace the IR or NIR source.
   Video: Replacing the IR Source
   Video: Replacing the NIR Source

   **Note** Each source is uniquely pinned so that it can only be installed in a specific mounting position. Locate the alignment pins in the source position on the source mount. Orient the source so that the pins on the source mount are aligned with the holes on the source.

2. Install the back cover. For an ABX, see Replacing the ABX Cover.

3. Install the sample compartment cover.

4. Connect the power supply.

5. Turn the spectrometer on.

   Verify that the source is working. When the source is working properly, the status LED remains steady blue after the power-up diagnostics is complete.

   If the status LED flashes yellow, the source may not be working. Make sure it is seated firmly on the source mount and the knob is tightened. If the source still does not work, contact us.

6. Configure the source in OMNIC. Go to Collect > Experiment Setup > Bench tab and select the source type from the drop-down list.

   **Note** You may notice increased levels of water and carbon dioxide in spectra collected immediately after you have had the cover open. If this interferes with your data, wait several minutes for equilibrium to be re-established.
Replacing the Laser

**CAUTION** Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.

Time needed: 30 minutes or less

Tools needed: Flathead screwdriver

❖ To replace the laser

1. Turn the spectrometer off.
2. Disconnect the power supply.
3. Remove the laser.
   Video: Removing the laser
4. Replace the laser.
   Video: Replacing the laser
5. Connect the power supply.
6. Turn the spectrometer on.
7. Verify that the laser is working.

If the laser is working properly, the status LED remains steady blue after the power-up diagnostics complete and you will see a red dot of light if you hold a card or piece of paper in the sample compartment.

Replacing the Power Supply

**CAUTION** Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.

**NOTICE** Do not place the power supply on top of the spectrometer; it is a heat source and may affect your experiment results. Place the power supply on the table or the floor for best results.

Time needed: Five minutes or less

Tools needed: None
To remove the power supply

1. Turn the spectrometer off.
2. Remove the power cord from the power strip or wall outlet.
3. Remove the power supply.

Video: Removing the power supply

To replace the power supply

1. Connect the power supply cable to the spectrometer as shown in this video.

Video: Replacing the power supply
2. Connect the power cord to the wall outlet or power strip.

When the green light on the power supply is on, this indicates that the power supply is plugged into a power source.
3. Turn the spectrometer on.

The status LED light on the top of the back panel of the spectrometer will appear blue and blink several times as the spectrometer powers up and runs its diagnostic routine. The scan light will intermittently blink blue indicating that the spectrometer is scanning.

If the spectrometer does not function normally, turn the power off and check the cable connections between the power supply, the spectrometer, and the wall outlet or power strip, and then turn the power back on. If the spectrometer still does not function normally, contact us.

Replacing the Sample Compartment Windows

WARNING  Avoid personal injury.

- Never stare into the laser beam or at its bright reflection. Never tamper with the laser, even if you are replacing a defective laser. Exposure to laser light or high voltage may result.
- Use of controls or adjustments or performance of procedures other than those specified in your user information may result in hazardous radiation exposure.

CAUTION  Avoid shock hazard. Be sure to unplug the system from the power source before servicing any replacement parts.

There is a window on each side of the sample compartment that seals the spectrometer from moisture and other contaminants. They are also referred to as Purge windows.
These windows must be used whether or not the spectrometer is purged. This protects the instrument. However, if the spectrometer is equipped with Automatic Purge Shutters, the sample compartment windows are not necessary. Also, the windows may need to be removed for certain experiments and spectral ranges or to allow purge to flow into an accessory. When the windows are removed they should be replaced with the open ring assemblies that came with your system to maintain proper seal with your accessories.

The windows are made of either potassium bromide (KBr) or Cesium Iodide (CsI). All windows must be clear, clean, and free of fingerprints.

**NOTICE**

- Replace the sample compartment windows only with replacement parts supplied by us.
- Do not push on the window, rubber gasket, or bracket in any way that bends or distorts the window; the window can crack or break. Damage or breakage during installation is not covered by warranty.
- Do not allow liquids to come into contact with the sample compartment windows.
- Windows can be scratched and ruined very easily. Do not touch or attempt to clean them. Dust will not affect the signal, but fingerprints will degrade the performance of the instrument and permanently damage windows. If you wish to remove dust from a window, blow it off with a gentle stream of pure nitrogen. Do not use compressed air (from a can or an air compressor). Contaminants will damage the windows.
- Wear non-powdered latex-free gloves or finger cots to handle replacement windows and hold them only by the rims. Avoid touching the window surface even when wearing gloves.
- The window fittings are tight. Use one hand to stabilize the instrument and the other to remove the window.
- If your instrument is purged, you can leave the purge on while you replace the windows to prevent ambient air from entering the spectrometer.
**Time needed:** 10 minutes

**Tools needed:** Non-powdered, Latex-free gloves, or finger cots, Philips-head screwdriver

✧ **To remove a sample compartment window**

1. Put on gloves or finger cots.

2. Open the sample compartment cover. Remove any sample compartment accessories before attempting to remove or install a sample compartment window.

3. Loosen the four bracket screws with the screwdriver to free the bracket from the sample compartment wall.

4. Carefully remove the bracket and sample compartment window together. The window and rubber gasket are a single unit that sits inside the opening of the bracket, but the gasket is not attached to the bracket.

5. Lift the window out of the bracket. Hold it **only by the edges.**
6. Place it into its protective packaging

*To install a sample compartment window*

1. Place the window assembly into the bracket with the flat, window-side up. The flat side of the window assembly faces the spectrometer wall opening.

2. Carefully lift the window and bracket and place it against the sample compartment opening. Be careful not to let the window assembly fall out of the bracket.

3. Place the bracket with the sample compartment window against the sample compartment wall opening, making sure the window fits tightly into the opening.
4. Insert a screw into each of the four holes of the bracket to attach it to the sample compartment wall.

5. Configure the new sample compartment window in OMNIC software. See “Configuring the System Hardware” in the OMNIC online help.

6. Wait for at least 15 minutes (one to six hours for best results) for the spectrometer to gain equilibrium.
Troubleshooting

This troubleshooting information will help you solve problems you may have with the system. The information is divided as follows:

<table>
<thead>
<tr>
<th>Problem type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Problems</td>
<td>How to address problems with the software.</td>
</tr>
<tr>
<td>Hardware Problems</td>
<td>How to resolve problems with the spectrometer.</td>
</tr>
<tr>
<td>Applications Problems</td>
<td>How to fix problems in the collected spectra.</td>
</tr>
<tr>
<td>Error Messages</td>
<td>How to deal with error messages you may see.</td>
</tr>
</tbody>
</table>

To expedite and assist in problem diagnosis, please be prepared to send us a copy of your diagnostics log file. The diagnostics log includes a history of important system parameters and events that occur during system operation. To copy the diagnostics log to your Windows desktop, start OMNIC software and choose File > Copy Diagnostics File to Desktop.

Software Problems

CAUTION Avoid personal injury. Perform only those procedures described in the documentation. If there are other problems, contact us. Any other service must be performed by trained personnel.

The OMNIC software automatically and continuously checks the status of your system. If a problem is found, a message appears giving you access to more information. This section provides simple troubleshooting measures you can take to solve problems with OMNIC software. If the action does not solve the problem, contact us.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experiment provided with OMNIC does not produce good results.</td>
<td>Parameter settings in the experiment file have been changed so that experiment file is no longer accurate.</td>
<td>Restore the experiment to its default settings:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Open the experiment using <a href="#">Experiment Setup</a> and save it using a new filename if you do not want to overwrite it.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Open the experiment in the <a href="#">FACTORY</a> directory whose filename is same as the original experiment. Save it in <a href="#">OMNIC\Param\Factory</a>.</td>
</tr>
<tr>
<td>Desired experiment does not appear in the Experiment drop-down list box.</td>
<td>Experiment was installed with the software but has not yet been opened.</td>
<td>If experiment was designed for a Smart accessory, install the accessory. The experiment will open automatically and will appear in the Experiment drop-down list box. If the experiment was not designed for a Smart accessory, open the experiment using <a href="#">Experiment Setup</a> to add it to the list.</td>
</tr>
<tr>
<td>Quantify command is dimmed.</td>
<td>No quantitative analysis method is selected.</td>
<td>Select a quantitative analysis method using <a href="#">Quant Setup</a> in the Analyze menu.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select a single spectrum.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select an appropriate method for the selected spectrum.</td>
</tr>
<tr>
<td>You cannot add a spectrum to the user library.</td>
<td>Resolution of the spectrum is lower (higher numerical value) than that of the library.</td>
<td>Collect the spectrum at the same resolution as the library (first set <a href="#">Resolution on Bench</a> tab of <a href="#">Experiment Setup</a> dialog box), and then add it to library.</td>
</tr>
<tr>
<td></td>
<td>The spectrum is from a commercial library.</td>
<td>Spectra you collect can be added only to a user library. Commercial libraries cannot be altered and the spectra contained in them cannot be copied to other libraries.</td>
</tr>
<tr>
<td>Experiment results are much different than expected</td>
<td>Configuration issues.</td>
<td>Verify that your experiment settings and bench configuration are accurate.</td>
</tr>
</tbody>
</table>
Hardware Problems

The System Status indicator below the OMNIC menu bar shows the status of the spectrometer operation. The following conditions indicate OMNIC has detected a problem with the spectrometer:

- If the indicator is yellow, there was a problem found, but it did not cause the spectrometer to fail the test. A message identifies the problem and tells you where to find instructions to fix it.
- If the indicator is red, the spectrometer has failed a diagnostic test and requires corrective action. A message explains the problem and directs you to information on how to correct it.

This section lists simple troubleshooting measures you can take to solve problems with the spectrometer. More information is provided in Diagnostics. If the problem continues after following these troubleshooting tips, contact us.

**CAUTION** Avoid personal injury. Perform only those procedures described in the documentation. If there are other problems, contact us. Any other service must be performed by trained personnel.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status indicator does not light when spectrometer is turned on.</td>
<td>Spectrometer is not plugged in.</td>
<td>Make sure the power cord is plugged into the spectrometer and a working wall outlet.</td>
</tr>
<tr>
<td></td>
<td>Power cord or power supply is defective.</td>
<td>Replace the power supply. See Replacing the Power Supply for instructions.</td>
</tr>
<tr>
<td>Status indicator light is blinking yellow.</td>
<td>Humidity too high at power-up.</td>
<td>Regenerate or replace the desiccant, check purge flow if installed.</td>
</tr>
<tr>
<td></td>
<td>Temperature too low or too high.</td>
<td>Let the system stabilize.</td>
</tr>
<tr>
<td></td>
<td>Motorized movement problem (including in NIR, ABX, or ATR).</td>
<td>Clear the obstruction.</td>
</tr>
<tr>
<td></td>
<td>Unable to scan.</td>
<td>Verify laser is on. Beamsplitter may be fogged.</td>
</tr>
<tr>
<td></td>
<td>Laser current or voltage out of specification</td>
<td>Replace the laser.</td>
</tr>
<tr>
<td></td>
<td>Source current or voltage out of specification (whatever source is set to on)</td>
<td>Replace the source.</td>
</tr>
<tr>
<td></td>
<td>Currently selected Nitrogen-cooled detector is warm (including in GC).</td>
<td>Cool MCT detector with about 1 L of LN₂.</td>
</tr>
<tr>
<td>Data is not displayed during collection.</td>
<td>Laser is malfunctioning.</td>
<td>Hold a business card or other small piece of white paper in the beam path in the sample compartment to check for the laser light. Replace the laser if necessary. See Replacing the Laser for instructions.</td>
</tr>
<tr>
<td></td>
<td>Data cable between the spectrometer and the computer is not properly connected or is damaged.</td>
<td>Turn spectrometer power off and check the data cable connections. If the cable is damaged, replace it. Contact us to order a replacement cable.</td>
</tr>
<tr>
<td>System does not scan.</td>
<td>Laser is flickering.</td>
<td>Hold a business card or other small piece of white paper in the beam path in the sample compartment to see if laser light flickers. Turn the power off and contact us.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>There is frost on the outside of a Nitrogen-cooled detector.</td>
<td>Insulating vacuum chamber surrounding the dewar is leaking.</td>
<td>If you suspect your detector has a vacuum leak, contact us about having the dewar pumped to replace the vacuum. The dewar or the detector may need to be replaced. Contact us to order a replacement.</td>
</tr>
<tr>
<td>The currently selected Nitrogen-cooled detector is warm.</td>
<td>Not enough liquid Nitrogen in dewar.</td>
<td>Check the liquid Nitrogen level in the detector dewar. If low, add more liquid Nitrogen.</td>
</tr>
<tr>
<td></td>
<td>Insulating vacuum chamber surrounding the dewar is leaking.</td>
<td>Contact us about having the dewar pumped to replace the vacuum.</td>
</tr>
<tr>
<td></td>
<td>Dewar is malfunctioning.</td>
<td>Replace the dewar. Contact us to order a replacement dewar.</td>
</tr>
<tr>
<td></td>
<td>Detector is malfunctioning.</td>
<td>Replace the detector. See Changing a Detector for instructions. Contact us to order a replacement detector.</td>
</tr>
<tr>
<td>Baseline is not stable.</td>
<td>Purge rate is too high.</td>
<td>Lower the purge rate until the baseline is stable. See Setting Purge Gas Controls for recommended settings.</td>
</tr>
<tr>
<td></td>
<td>Interferometer is misaligned.</td>
<td>Align the spectrometer using Align bench on the Diagnostic tab in the Experiment Setup dialog box. See Aligning the Spectrometer for instructions. If levels remain out of tolerance, contact us for service.</td>
</tr>
<tr>
<td></td>
<td>Desiccant is expired.</td>
<td>Regenerate or replace the desiccant.</td>
</tr>
<tr>
<td></td>
<td>Spectrometer cover was recently opened.</td>
<td>Allow the spectrometer to stabilize for 3 to 5 minutes after the cover is closed.</td>
</tr>
</tbody>
</table>
**Troubleshooting**

**Hardware Problems**

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal intensity is low in Mid-IR range.</td>
<td>Something is blocking the beam.</td>
<td>Open the aperture to 100 and make sure all filters, screens or polarizers are out of the beam. Make sure there is no sample or accessory in the sample compartment.</td>
</tr>
<tr>
<td></td>
<td>The ATR crystal may not be installed.</td>
<td>Install an ATR crystal plate.</td>
</tr>
<tr>
<td></td>
<td>Source is not glowing.</td>
<td>Check to see if the source element is glowing evenly. If it is not, replace the source. See Replacing the Light Source for installation instructions.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>System scans but gives very low signal intensity.</td>
<td>Spectrometer is out of alignment.</td>
<td>Align the spectrometer using Align on the Diagnostic tab in the Experiment Setup dialog box. See Aligning the Spectrometer for instructions.</td>
</tr>
<tr>
<td></td>
<td>Detector and beamsplitter are not compatible.</td>
<td>Make sure that selected detector and beamsplitter are compatible. See Beamsplitter and Detector Compatibility.</td>
</tr>
<tr>
<td></td>
<td>There is no interferogram.</td>
<td>If the source status indicator is off, click source indicator on the Diagnostic tab in the Experiment Setup dialog box to check source current and voltage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the source status indicator is on, check interferogram on the Bench tab in the Experiment Setup dialog box; if the interferogram is not present, check the beampath and detector.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ensure nothing is blocking the beam path. Remove filters or screens from the beam.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Make sure there is no purge shutter in beam.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If using an ATR, make sure the crystal plate is installed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click Reset Bench on the Diagnostics tab.</td>
</tr>
<tr>
<td>Problems encountered when selecting external detectors on GC interface or microscope.</td>
<td>Custom detector is selected on Bench tab of Experiment Setup dialog box.</td>
<td>Set Detector to None on the Bench tab of the Experiment Setup dialog box.</td>
</tr>
<tr>
<td></td>
<td>Detector cable is loose at the accessory connector (on the back of the spectrometer or on the back wall of the sample compartment).</td>
<td>Check and tighten cables.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Signal intensity is low, there are frequent modulator-scan restarts</td>
<td>Beamsplitter is partially fogged.</td>
<td>Remove the beamsplitter and check its center window for fogging (check</td>
</tr>
<tr>
<td>(verified by intermittent flashing of the Scan indicator), and the</td>
<td>Beamsplitter is not completely inserted.</td>
<td>the clear area located in center of substrate).</td>
</tr>
<tr>
<td>spectrometer alignment fails.</td>
<td></td>
<td>Replace the beamsplitter if necessary. See **Manually Installing a</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Beamsplitter**, <strong>Manually Removing a Beamsplitter</strong>, or **Using the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>iS50 ABX (Optional)** if you have an iS50 ABX, for instructions.</td>
</tr>
<tr>
<td>Scan status indicator does not flash (system is not scanning).</td>
<td>Spectrometer is out of alignment.</td>
<td>Align spectrometer using <strong>Align</strong> on the <strong>Diagnostic</strong> tab in the</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Experiment Setup</strong> dialog box. See <strong>Aligning the Spectrometer</strong> for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>instructions.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>After one hour without data collection activity, the interferometer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>stops scanning and the Scan light stays on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No action is required. Any data collection activity will cause the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>interferometer to begin scanning. This mode is normal.</td>
</tr>
<tr>
<td></td>
<td>Beamsplitter is not properly inserted.</td>
<td>Check the beamsplitter and reposition it if necessary. See **Manually</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Installing a Beamsplitter**, <strong>Manually Removing a Beamsplitter</strong>, or</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Using the iS50 ABX (Optional)</strong> if you have an iS50 ABX, for</td>
</tr>
<tr>
<td></td>
<td></td>
<td>instructions.</td>
</tr>
<tr>
<td></td>
<td>Beamsplitter compartment cover is open.</td>
<td>Close the cover and latch it. See <strong>Manually Installing a Beamsplitter</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Manually Removing a Beamsplitter</strong>, or <strong>Using the iS50 ABX (Optional)</strong>* if you have an iS50 ABX, for instructions.</td>
</tr>
<tr>
<td></td>
<td>Electronic error has occurred.</td>
<td>Turn the spectrometer power off and then on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unplug and plug the USB cable</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Contact us</strong> for service.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Error message appears when you try to scan.</td>
<td>Detector is not cooled.</td>
<td>Cool the detector. See Cooling a Detector for instructions.</td>
</tr>
<tr>
<td></td>
<td>Beam path is blocked.</td>
<td>Hold a small piece of white paper in the beam path in the sample compartment to check for laser light. If no laser light is visible, the beam path may be blocked. Remove obstruction.</td>
</tr>
<tr>
<td></td>
<td>Data cable between spectrometer and computer is not properly connected.</td>
<td>Turn off the spectrometer power and check the data cable connections. If any of the connections are loose, seat the connector firmly. If the cable is damaged, replace it. Contact us to order parts.</td>
</tr>
<tr>
<td></td>
<td>Detector, source, and beamsplitter are not compatible.</td>
<td>See Beamsplitter and Detector Compatibility for a listing of compatible combinations. Change the detector, beamsplitter, or source, as necessary.</td>
</tr>
<tr>
<td>Touch points are not acting as expected or other issues.</td>
<td>The spectrometer response time is more than specified time.</td>
<td>Something may be obstructing the movement of some optical component. Open the cover and check for proper movement.</td>
</tr>
<tr>
<td></td>
<td>The spectrometer dropped the communication to the software.</td>
<td>Make sure the USB cable is connected. Make sure the USB cable is connected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Turn the spectrometer off and then back on. If this doesn’t work, turn off both the computer and the spectrometer and then turn them back on.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
<td>----------</td>
</tr>
<tr>
<td>Beamsplitter was not loaded correctly or at all by the ABX.</td>
<td>Beamsplitter is misaligned while being inserted into the interferometer by the ABX.</td>
<td>Try loading the beamsplitter again using OMNIC.</td>
</tr>
<tr>
<td></td>
<td>Beamsplitter is misaligned on the ABX.</td>
<td>Try loading the beamsplitter again using OMNIC.</td>
</tr>
<tr>
<td>The spectrometer is not level.</td>
<td></td>
<td>Remove the ABX back cover and correct the beamsplitter alignment issue. The hanger may be loose from the beamsplitter, or the beamsplitter may be stuck on or outside of the guide tray.</td>
</tr>
<tr>
<td>A beamsplitter cannot be automatically changed or removed from the interferometer by the ABX.</td>
<td>Loss of power to the instrument has occurred or the ABX is otherwise not functioning correctly.</td>
<td>Manually unlock the beamsplitter from the interferometer by turning the knob on the latch motor until the latch releases and beamsplitter is loose and can safely be removed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manually turn the knob on the vertical motor to lift the beamsplitter out of the interferometer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manually rotate the beamsplitter carousel to the load position and remove the beamsplitter.</td>
</tr>
</tbody>
</table>
Applications Problems

If OMNIC’s spectral quality checking feature is enabled, the software automatically checks the status of collected interferograms, and background and sample spectra.

When the software detects a problem with data collection or spectra, the **Collect Status** indicator is displayed as a yellow circle or a red X. You can click the indicator (or click the **View Collect Status** button at the end of data collection) to see a summary of problems encountered.

This section provides simple troubleshooting measures you can take to solve data collection problems with the spectrometer. If the action does not solve the problem, contact us.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spectrum contains derivative-shaped peaks.</td>
<td>Sample in the diffuse reflection experiment also has a specular reflection component.</td>
<td>Correct the spectrum by using Other Corrections in the Process menu. Select Kramers-Kronig.</td>
</tr>
<tr>
<td></td>
<td>Infrared beam was reflected from (instead of penetrating) a flat, shiny sample measured using a specular reflection accessory.</td>
<td>Try using a less reflective sample.</td>
</tr>
<tr>
<td></td>
<td>An ATR spectrum was attempted on an extremely strong absorber or scatterer, such as carbon black rubber.</td>
<td>Try a Ge crystal on the ATR, if available. This decreases the depth of penetration.</td>
</tr>
<tr>
<td>Spectrum contains totally absorbing peaks.</td>
<td>Sample in the transmission experiment is too thick.</td>
<td>Decrease the pathlength by using a thinner sample.</td>
</tr>
<tr>
<td>Spectrum contains carbon dioxide peaks that are greater than normal.</td>
<td>Spectrometer is not adequately purged.</td>
<td>Make sure you are using the correct purge gas and that the purge flow rate is adequate. See Selecting a Purge Gas and Setting Purge Gas Controls for instructions. Allow the system three to five minutes to re-establish purge before collecting the spectrum.</td>
</tr>
</tbody>
</table>

In non-purged systems, the standard desiccant will absorb some of the carbon dioxide.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spectrum contains excessive water peaks.</td>
<td>Spectrometer is not adequately purged.</td>
<td>Make sure you are using the correct purge gas and that the purge flow rate is adequate. See Selecting a Purge Gas and Setting Purge Gas Controls for instructions. Allow system three to five minutes to re-establish purge before collecting the spectrum.</td>
</tr>
<tr>
<td></td>
<td>Desiccant is expired.</td>
<td>Check the desiccant indicator; if the color has turned pale blue or pink, regenerate or replace the desiccant.</td>
</tr>
<tr>
<td>There are no peaks in the spectrum.</td>
<td>There is no sample in infrared beam path.</td>
<td>Check the sample compartment or accessory to make sure the sample is properly positioned in the beam path.</td>
</tr>
<tr>
<td></td>
<td>Sample cup in the diffuse reflection experiment is not in place or is tilted.</td>
<td>Make sure the cup is properly positioned in the diffuse reflection accessory.</td>
</tr>
<tr>
<td></td>
<td>Infrared microscope is in its viewing mode.</td>
<td>Put the microscope in infrared mode and collect the spectrum again.</td>
</tr>
<tr>
<td></td>
<td>Sample film in the ATR experiment is being held against the ATR crystal with uneven pressure or has poor contact with crystal.</td>
<td>Make sure the sample is held evenly and has good contact with crystal.</td>
</tr>
<tr>
<td></td>
<td>Spectral range is incorrectly set.</td>
<td>Go to Experiment Setup &gt; Bench tab. Verify that the spectral range is set appropriately for the sample compartment accessory.</td>
</tr>
<tr>
<td>Spectrum contains fringes or channeling.</td>
<td>Sample has parallel, highly reflective sides that cause the infrared beam to bounce within a sample when it is placed perpendicular to beam. This may be normal performance if using liquid transmission cell. The fringes are useful for determining the pathlength of the cell.</td>
<td>Create a new film using a matte press. Try roughening the film surface slightly with silicon carbide paper or other suitable abrasive. Rotate the sample so that the infrared beam passes through the sample at Brewster's angle. (Do not use this method if you are performing quantitative analysis.)</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Baseline of the spectrum is not flat.</td>
<td>KBr pellet was made with coarsely ground KBr powder, or KBr pellet was improperly pressed.</td>
<td>Be sure to grind the KBr finely, and to press the pellet until it is almost visibly transparent.</td>
</tr>
<tr>
<td></td>
<td>Background spectrum for cast film was collected with an empty sample holder.</td>
<td>Remove the sample holder and collect the background again.</td>
</tr>
<tr>
<td></td>
<td>Baseline is sloped in ATR.</td>
<td>Strongly scattering samples, such as oils containing soot or rubbers with high carbon black content, will cause strongly sloping backgrounds. This is normal and an inherent part of the sample.</td>
</tr>
<tr>
<td></td>
<td>Spectrometer is not properly aligned, causing a sloped baseline.</td>
<td>Use Align on the Diagnostic tab in the Experiment Setup dialog box to align the spectrometer. See Aligning the Spectrometer for instructions.</td>
</tr>
<tr>
<td></td>
<td>Spectrometer has not been on long enough to reach thermal equilibrium.</td>
<td>Make sure the FTIR system power is always on.</td>
</tr>
<tr>
<td></td>
<td>Spectrometer is not properly purged.</td>
<td>Make sure you are using the correct purge gas and that the purge flow rate is adequate. See Selecting a Purge Gas and Setting Purge Gas Controls for instructions. Allow the system three to five minutes to re-establish purge before collecting the spectrum.</td>
</tr>
</tbody>
</table>
Error Messages

This section provides simple troubleshooting measures to deal with error messages you may see. The system status icon in the upper right corner turns red. The user can click on the red shield and a dialog is presented that has a button labeled “Explain Error”. Clicking that button brings up help.

If the action does not solve the problem, contact us.

Alignment Error

OMNIC software was unable to align the spectrometer.

To align the spectrometer

1. Open OMNIC software.
2. Click Collect > Experiment Setup.
3. Click the Diagnostics tab.
4. Click Bench Align.
The Spectrometer is not Scanning

1. Make sure the beamsplitter is installed and seated properly.
2. Check to see if the beamsplitter is fogged.
3. Check the laser and replace it if necessary.
4. Contact us.

Humidity Level Inside Spectrometer is too High

❖ To reduce the humidity level for a spectrometer that is sealed and desiccated

1. Check the desiccant indicator; if the color has turned pale blue or pink, regenerate or replace the desiccant.
2. Check and, if necessary, replace the sample compartment windows and port windows or instrument optical covers.
3. Contact us.

❖ To reduce the humidity level for a spectrometer that is purged

1. Verify that your purge gas controls are installed and set correctly.
2. Check the purge filter and, if necessary, change it.
3. Contact us.

Computer Cannot Communicate with Spectrometer

❖ To check the spectrometer connection

1. If the spectrometer is turned off, turn it on.
2. Check the data cable between the computer and the spectrometer. If it is disconnected, connect it.
3. If the top panel status indicator panel indicators are not on:
   • Make sure the spectrometer is plugged in.
   • Replace the power supply.
4. Contact us.
Spectrometer Cannot Communicate with the Detector

 To check the detector connection
1. Open the detector hatch and make sure a detector is installed correctly.
2. Make sure the ribbon cable is connected to the detector.
3. Make sure the detector is selected in the software.
4. Replace the detector, if necessary.
5. Contact us.

Spectrometer Temperature is out of Specification

 To check the temperature
1. Check the cooling vents. Remove any obstructions.
2. Remove any items stacked on the electronics cover.
3. The ambient temperature in your lab may be too high. Cool the room to between 20 °C and 22 °C (68 °F and 72 °F).
4. Contact us.

Power Supply is out of Tolerance

 To check the power supply
1. Verify that the power supply is connected to the spectrometer and to the power outlet.
2. Click Collect > Advanced Diagnostics. Select power supply.
3. Replace the power supply.
4. Contact us.

Laser is out of Specification

 To check the laser
1. Make sure the HeNe laser is visible, using a white card in the sample compartment. Replace the laser if necessary.
2. If the laser has been recently replaced, verify the power connection and that the assembly is properly seated.
**Laser Temperature is out of Specification**

1. If the laser has been recently replaced, verify the power connection and that the assembly is properly seated.
2. The laser may need replacement. Contact us for ordering information. The laser is user-replaceable.

**Laser Frequency is out of Specification**

1. If the laser has been recently replaced, verify the power connection and that the assembly is properly seated.
2. The laser may need replacement. Contact us for ordering information. The laser is user-replaceable.

**Electronics Module is not Responding Properly**

- To check the electronics module
  1. Go to the Diagnostics tab in Experiment Setup. Click Reset Bench.
  2. Turn the spectrometer power off and then on again.
  3. Contact us.

**Source Voltage is out of Specification**

- To check the source
  1. Ensure the source is mounted correctly on the source mirror assembly and that the thumb screw is tight. This makes the necessary electrical connections.
  2. The source may need replacement. Contact us for ordering information. The source is user-replaceable.

**MCT Detector is Warm or Saturated**

1. Ensure the detector is cooled with liquid Nitrogen.
2. Insert an attenuation screen into the beam or decrease the aperture setting to reduce the light on the detector.
3. Check the detector dewar.
4. Replace the detector.
5. Contact us.
Communication Error

A communication error between the computer and spectrometer occurred. Turn the computer and spectrometer off and then back on.

Motor Error

A motorized component on the bench could not complete the requested action. Check inside the spectrometer for any obstructions, turn the computer and spectrometer off and then back on, and if the error persists, call service.

Motor Timeout

A motorized component failed to respond or communicate. Check inside the spectrometer for any obstructions, turn the computer and spectrometer off and then back on, and if the error persists, call service.

Motor Not Responding

A motorized component expected to be present did not respond. Check inside the spectrometer for disconnected cables, turn the computer and spectrometer off and then back on, and if the error persists, call service.

ABX is Missing a Beamsplitter

A requested beamsplitter is missing or could not be found by OMNIC. If the spectrometer is configured to use a beamsplitter loaded in a particular position but the beamsplitter is not present, whenever that beamsplitter is selected for use in OMNIC, this error occurs.

Put the beamsplitter in the appropriate position in the ABX, or change the spectrometer configuration to reflect that there is no beamsplitter in that position. Beamsplitters are configured on the Configure tab of Experiment Setup in OMNIC.

Setting Smart Purge Controls

Smart Purge is not an option for the Nicolet iS50 spectrometer.
Research Module

The research module is an external optical breadboard with purgeable enclosure interfaced to the iS50 or iS50R spectrometer using a custom mounting plate. The research module is used to perform experiments that are either physically too large to set up in the main sample compartment of the spectrometer or experiments that require specialized components. Pre-configured optics kits are available to support popular specialized spectroscopy techniques. You can also develop your own optical systems by using standard opto-mechanical products from third-party suppliers and mounting them on the optical breadboard. The research module is only for use with the iS50 and iS50R spectrometers.

Dimensions

At the beam ports on the sides of the spectrometer, the shape of the IR light beam is a round spot that is approximately 1.5 inches in diameter.

In the research module, the center of the beam is 6.87 inches above the top of the table or counter used to support the spectrometer and accessories. The center of the beam is 4 inches above the top surface of the sample compartment baseplate. See the diagram below for more dimensions from the both the top and side views of the research module.
Connecting an External Detector to the Spectrometer

The research module is equipped with a bulkhead connector on one wall to create a passthrough connection from a detector mounted in the research module to the spectrometer. The bulkhead connector has two ports: a 9-pin D-connector and a 15-pin D-connector.

The research module detector mounting kit contains the components to install an external detector into the research module. It includes a detector baseplate and mounting hardware.

For accessories with detectors not automatically recognized by the iS50/iS50R spectrometer, an external detector interface kit is required and available from Thermo Scientific. This kit enables the spectrometer to recognize unknown external detectors. The kit communicates the detector type and detector address to the spectrometer after some minor configuring of the interface box.

Pre-configured Advanced Experiment Kits

Three pre-configured Advanced Experiment Kits are available from Thermo Scientific:

- PM-IRRAS
- VCD
- VCD + PM-IRRAS

You can also set up custom configurations to perform other types of experiments. See the OMNIC SST Online Help for more information.